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CHAPTER ONE

WHAT IS EXCEL

The Excel worksheet is an electronic ledger created by the Microsoft Excel
spreadsheet program.

Excel is nothing more than a series of rows and columns separated into cells.
In a way, the table is just another form of a workbook. A table is only one of
many object users that can be inserted into an Excel worksheet. A table
serves so many other functions than a worksheet can or is meant to do.

Worksheets are used to allow users to store and manipulate data in rows and
columns separated into cells. Worksheets often enable users to quickly
construct equations and logical functions to execute different features for
each particular worksheet. Worksheets allow users to sort and process infinite
quantities of data in many specific and familiar ways. Such data can be
imported and exported to and from a variety of sources.
Excel is usually used to arrange data and carry out a financial review. Excel
is used for a lot of organization functions, and from small to large businesses
and companies.

The essential uses of Excel include Data Entry, Data Processing, Accounting,
Financial Analysis, Charting and Graphing Programming, Time Processing,
Task Management, and Customer Relationship Management (CRM). Almost
everything that needs to be organized!

Data Features, Formulas, and Shortcuts

Excel software provides several functions, formulas, and shortcuts that can be
used to improve its functionality.

Business and Accounting Use

Excel is commonly used in finance and accounting functions. Also, several
companies are running their entire budgeting, forecasting, and accounting
functions entirely out of Excel spreadsheets.



Although Excel is described as a "data" management tool, the most
commonly managed data is financial. At CFI, Excel would be described as
the ultimate financial software. While there are other pieces of financial
software designed to perform specific tasks, the strongest point about Excel is
its robustness and transparency. Excel models are as strong as the analyst
needs them to be.

Accountants, investment bankers, analysts, and people on all kinds of
financial career paths rely on excel to conduct their daily job functions.

Excel is a spreadsheet application software that enables the users to store,
modify, and manipulate data in a set of table-like structures known as a
workbook. The workbook uses a series of worksheets to arrange data within a
structure or row and columns separated into cells. Users can insert data or
numbers in these cells to make it easy to calculate simple or complex
formulas. Users may insert items such as charts and graphs into their
workbooks to graphically represent their entered data in a variety of unique
ways.

Difference Between Tables and Worksheets 

A worksheet uses thousands and thousands of rows and columns, sometimes
even a million. Nonetheless, tables are designed to use smaller numbers of
rows and columns to organize related information for sorting and filtering
purposes. Tables also allow the use of links to external networks, although
worksheets do not enable the use of tables.

Formatting Tables

Tables can use most of the same formatting options available to worksheets;
however, tables provide Excel users with a toolbar not only for formatting
tables, but to import and export data from external networks, display and use
more tools available in Excel tables, and even sort and filter the values inside
the table in terms of current demand.

Edit Values in Tables

One of the most valuable aspects of the tables is their ability to allow you to



start editing their values or formulas the same way you would have if you
hadn't even built a table. Still, the same tables also allow for additional
flexibility. You can also easily edit, add or remove any value inside any table.

Importing a Table from External Resources 

Importing a table from external resources can be achieved in many ways. The
perfect way to do this is to use the copy and paste process, where you only
copy the data from the external resource and paste it into your worksheet.
There are several different problems with this form. One of the core issues
connected with the copy and paste approach is that Excel doesn't understand
why you want to create a table automatically. This means that after you copy
and paste the details on your worksheet, you have to place the data into a
table in the worksheet.

Exporting Tables to External Resources

Exporting tables within Excel can be as easy as using the same copy and
paste process that can be used to import data or as complex as exporting to
different applications using various interfaces and menus. The copy and paste
approach is the same as if you were importing data, except that you can use
the copy portion to transfer the data from your Excel table and paste portion
to export the data to the external network. Using different exporting menus
and interfaces allows a lot more flexibility, but needs a lot more knowledge
of standard formats and external resource structures.

Who Created Excel from Microsoft

Excel was developed by Microsoft Corporation in 1984. This was designed to
provide a more effective, user-friendly way for spreadsheet users to measure
data without having to deal with the DOS command line. It was initially
planned for use with Apple computers. Since Microsoft Windows was first
released in 1987, Microsoft Excel was one of the first applications to be
developed for Microsoft Windows. It was the only window dependent
spreadsheet program until 1992.

Where are the Pieces on Your Worksheet?



Worksheets consist of four primary sections. The cell is the most widely used
component of the Excel workbook. Cells are where users can enter the data to
be used in calculations and charts later. Each cell is made up of a column and
a row; A column is all cells in a single vertical line in the worksheet. Panel
titles can be found around the top of the workbook. A row is a series of cells
in a horizontal line around the workbook. You will see the names of the row
or the values scrolling down to the left of the worksheet.

What are the Characteristics of the Workbook?

Worksheets provide Excel users with a range of features. The primary
function offered by the worksheets is the ability to store and manage data in a
single central location. Nevertheless, with the development of worksheets,
users can now measure both basic and complex math and financial problems
as well as display their stored data with any specific custom charts and
graphs.

Why does Excel Store Worksheets for You?

Worksheets are contained in an Excel file called a workbook. Such
workbooks are what Excel uses to systematically arrange all the various
related sections of several similar worksheets, as well as the same maps,
graphs, and other objects within Excel.

How Many Worksheets Can be Created in a Single Workbook?

Before the release of Excel 2007, users could only build 255 in a single
workbook. Nevertheless, with the introduction of Excel 2007, users can now
create as many worksheets inside a workbook as the memory of the machine
can accommodate. However, if the user does not have access to one of the
newest versions of Excel, such as Excel 2007 or Excel 2010, they can still
create as many worksheets as they want, but older versions of Excel would
need more workbooks.

Microsoft Excel Tools has also developed useful tools and menus for Excel
users to be more personalized inside their own unique Excel programs and
workbooks. The Easy Access Toolbar has been designed to allow users to



build a simple way to access frequently used commands. This toolbar can be
personalized with an Excel program or a different workbook. The ribbon was
created by Excel to replace the older versions of the Excel menu. The ribbon
included the ability of Excel users to configure the ribbon to suit their unique
specifications.

Microsoft Excel File Types has also developed different kinds of ways to
save workbooks and other Excel files. Through the introduction of new file
types, Excel developed an import and export function that allowed Excel
users to easily import already developed workbooks or files and export
workbooks or files that could be used later.



CHAPTER TWO

OPENING EXCEL WORKSHEET

Opening Excel: There are various ways to open an Excel workbook,
depending on whether you want to open a new workbook or an existing
workbook and also depending on the year.

Open Excel from Start Menu
1. Select Start > All Programs > Microsoft (Office) Excel
2. Click Microsoft Excel Shortcut on Screen Opening and Excel Excel
Workbook Double click on the workbook from the My Documents/Computer
browser.

The Excel Screen

Depending on the settings of your device, you can see the Excel Task view
appear on the side of the Excel screen.
If the default settings have not been updated, you can also note that the new
workbook includes three blank worksheets and two toolbars at the top of the
screen; the Main toolbar and the Formatting toolbar.

Menus Worksheets contain toolbars and menus, as with all Microsoft Office
products, which provide commands to tell the system what you want it to do.
Standard Microsoft Office Menus:

File
Edit
View
Tools
Help

Additional Excel menus:

Insert
Format
Table
Window



Accessing commands from the menu:

1. Click on a menu name
2. Click on required command (you may need to click on to view all

commands)

Toolbars

Toolbars are just another way to access commands. Each button on the
taskbar represents a different order. The power will run when these buttons
are pressed.

Shortcut Keys

Shortcut keys allow you to run commands using the keyboard instead of the
mouse menus or toolbars. Using these shortcut keys will make working in
Excel much faster. The only challenge is remembering the shortcut keys!

Useful Shortcut keys:

Navigating in Excel
Ctrl+End-Go to the end of the workspace
Ctrl+Home-Return to cell
A1 Page Up-Go to the previous screen up Page Down-Go to the next screen
down
Alt+Page Up-Go to the previous screen left 
Alt+Page Down-Go to the next screen right 
Ctrl+Arrow down-Go to the bottom of the range/sheet 
Ctrl+Arrow Up-Go to the top of the range/sheet 

It is also necessary to save your files in an appropriate place, again in case of
a computer fault, but also for ease of retrieval.

A workbook can be saved at any stage (not just when it's finished). It is,
therefore, best to save the File as soon as it is made.

Save the workbook:
1. Go to File> Save As



2. Pick the folder to save the spreadsheet 
3. Type the name of the workbook 
4. Tap Save

What is the Difference Between 'Save' and 'Save As'?

Save-Updates, the latest script, i.e., save it over the top of the original
workbook. This can only open the dialog box when the workbook is saved
for the first time.

Save As allows you to change the file name or file position to make a copy of
the original workbook. When the Save As command is selected, the dialog
box is opened.

If working on any document, press the Save button every few minutes to
ensure that the current version of the document is saved on your computer if
there is a technical error.

Closing the Windows workbook allows users to have more than one program
open at any given time. This also enables users to have more than one
document open inside the program at any time, and there are many ways to
close the workbook.

There are three standard methods for closing a file in a Windows application: 
• Close the folder, i.e., Excel 
• Open the current workbook (leaving Excel open) 
• Open all existing workbooks (leaving Excel open) The Exit button is
located at the bottom of the File menu. Selecting this will close Excel and
open all of the workbooks. Towards the top of the File menu, click the Close
button. This will close the current workbook when chosen.

When you want to close all of the open workbooks but leave Excel available,
you don't have to close each of them individually. You should keep the Shift
key down and then open the File menu.
If you open or save worksheets in OpenDocument Spreadsheet (.ods) format,
some formatting can be expended. This is as a result of the various features
and choices, such as formatting and tables, that OpenDocument Spreadsheet
applications and Excel applications support. 



Tip: Before you submit a file to anyone else, you may want to shut the File
and initiate it once more to observe what it looks like in the OpenDocument
Spreadsheet (.ods) format. To compare the Excel file format with the
OpenDocument spreadsheet file format, first save the File in Excel format,
then open both the Excel version and the OpenDocument Spreadsheet
version, and visually examine the File for discrepancies.

The advantage of .xlsx format is that it uses ZIP file compression, so
spreadsheet files are much smaller than the original file format. The
compression ratio can be up to 75% lower. Due to the reduced file size, users
can easily share their workbooks via emails, portable drives, or even the
internet.

With the new file system, Microsoft has enhanced the reliability of the Excel
program and become less error-prone. The .xlsx file now divides the ordinary
text, macro codes, and images into different parts. Microsoft believes that this
approach eventually results in more stable applications. With this kind of
layout, if some portion of the Excel file is destroyed, e.g., due to a hard drive
collision, the user has a better chance of retrieving as much information as
possible from the erased File.

The .xlsx file extension simply uses an XML (extensible Markup Language)
format. As you might already know, XML is well known for its extensibility
and is a structured way to store information. This also means that many tech
companies or professional users can create custom software that uses Excel
documents. As long as Excel spreadsheets are stored in .xlsx, these
organizations can create software systems that retrieve the data they want
directly from the worksheet without the presence of Microsoft Excel. For
those who are familiar with the modern Excel file format, they can write a
program to create Excel documents on their own.
Nevertheless, Microsoft is now introducing two more new file formats.
Second, there is an extension of the closely related .xlsm format. This is a
unique format that provides the ability to store macro code. Microsoft Excel
will ask users to save the File to this extension if they have added any macros
to the spreadsheets. Second, Microsoft is now offering an optimized .xlsb
format. It is a format specifically built for faster opening and saving of large
spreadsheet files. The .xlsb form also provides compression and error-
resistance, such as .xlsx, but the data is stored in raw binary format to speed



up loading and saving. You may choose to save this file extension from the
Save As Tab, and then select Excel Binary Workbook (.xlsb) from the "Save
as Sort" list.

In most instances, users are advised to use the default file form, the .xlsx file
extension. The only time users need to remember is when they need to share
their workbooks with other users who may have different versions of Excel,
such as Excel 2003. If this is the case, then .xls could be a better extension to
use.
Microsoft Excel 2016

Displaying Multiple Workbooks and Worksheets This guide will teach you
how to display several workbooks and worksheets to help with your
workflow.
At any point, several workbooks or worksheets can need to be opened so that
data from different areas can be accessed.

Multiple PC Workbooks
Click File > Open to access a second workbook.
Use the View tab.
Choose Arrange Everything.
In the Windows dialog box, make sure the "Apps of Active Workbook" is
NOT picked. Then pick which of the arrangements is necessary.

Mac
Select File > Open the second workbook to open.
From the Mac menu bar, click Window.
Use the Arrange.

In the Windows dialog box, make sure the "Apps of Active Workbook" is
NOT selected. Then select which of the arrangements is needed.

Multiple Worksheet Desktop
Pick the Display tab.
Choose the Latest Window Tool. It will open the same workbook that is
already opened in a new window.
To organize the screens, click Organize Everything.

Mac



Pick Window > New Window from the Mac menu.
Select Window > Arrange the windows from the Mac menu bar.

Microsoft Excel 2016:Displaying Multiple Workbooks and Worksheets

This guide will teach you how to display several workbooks and worksheets
to help with your workflow.

At any point, several workbooks or worksheets may need to be opened so
that data from different areas can be accessed.

Multiple PC Workbooks
Click File > Open to access a second workbook.
Use the View tab.
Choose Arrange Everything.
In the Windows dialog box, make sure the "Apps of Active Workbook" is
NOT picked. Then pick which of the arrangements is necessary.

Mac
Select File > Open the second workbook to open.
From the Mac menu bar, click Window.
Use the Arrange.
In the Windows dialog box, make sure the "Apps of Active Workbook" is
NOT selected. Then select which of the arrangements is needed.

Multiple Worksheet Desktop
Pick the Display tab.
Choose the Latest Window Tool. It will open the same workbook that is
already opened in a new window.
To organize the screens, click Organize Everything.

Mac
Pick Window > New Window from the Mac menu.
Select Window > Arrange the windows from the Mac menu bar.

Excel files are referred to as workbooks. When you start a new project in
Excel, you will need to build a new workbook. There is a wide array of ways
to begin working with a workbook in Excel. You may opt to create a new
workbook — either with a blank workbook or a pre-designed template — or



open an existing workbook.

Creating a new blank workbook: select the File tab. The backstage view will
be shown.
Choose New, then press Blank Workbook.
There will be a new blank workbook.

Download an existing workbook: In addition to creating new workbooks, you
will also need to access a workbook that has already been saved. 

Navigate to the Backstage view, then press the Open button. Pick a screen,
then press the Browse button. Additionally, you can choose OneDrive to
access files that are saved on your OneDrive.

The Open dialog box will be shown. Locate and pick your workbook, and
then press Open.

If you have recently opened the desired workbook, you can browse your
recent workbooks instead of looking for a file.
To pin a workbook: If you always work with the same workbook, you can
add it to Backstage View for easier access.

Navigate to the Backstage view, then press the Open button. Your recently
edited workbooks will be published.
Move the mouse over the workbook that you want to add. Next to the
workbook, a pushpin icon will appear. Tap on the button of the pushpin.

The workbook is going to remain in the latest workbooks. Just press the
pushpin icon again to unpin the workbook.

Using Templates

A template is a pre-designed spreadsheet that you can use to create a new
workbook easily. Templates also provide custom templates and predefined
formulas, and they can save you a lot of time and effort when you start a new
project.

Creating a new workbook from a template: click the File tab to access the
Backstage view.



Choose Fresh. Several templates will appear below the white workbook
alternative.
Pick the template you want to study.
A sample of the template will appear, along with basic details about how to
use the template.
Select Build to use the template you have picked.
A new workbook will appear with the template you picked.
You may also search templates by category or use the search bar to find
something more basic.

It is relevant to note that not every model is developed by Microsoft. 

Some are generated by third party providers and even individual users, and
some templates can function better than others.

Compatibility Mode

You may need to work with workbooks created in earlier versions of
Microsoft Excel, such as Excel 2000 or Excel 2003. When you check these
types of worksheets, they should appear in the Compatibility Mode.
Compatibility Mode disables those functions, so you can only access
commands found in the software used to build a workbook. Take as an
example, if you initiate a workbook that was developed in Excel 2003, you
can only use the tabs and commands contained in Excel 2003.

To exit Compatibility Mode, you will need to convert the workbook to the
current version form. However, if you're working with someone who only has
access to an earlier version of Excel, it's better to leave the Compatibility
Mode workbook so that the format doesn't change.

To convert a workbook: if you want to have access to all of the 2016 Excel
functionality, you should convert a workbook to the 2016 file format.

Note that converting a file will trigger some changes to the original layout of
the workbook.

To control the Backstage view, press the File tab.
Locate and select Convert order.
The Save As dialog box appears. Make a selection of where you want to save



the workbook, enter the name of the workbook file, and press Save.
The workbook will be updated to the newest form of paper.

Within Excel 2019, you can use formulas to point to various pages,
workbooks, and cells. Such methods must automatically update and represent
changes in the active cell. Excel also allows teams the ability to make
comments on spreadsheets, protect cells, and allow a third party to modify
only a certain number of cells.

Reference for Other Worksheets 

Information for additional data is not limited to the current worksheet only.
Excel 2019 allows you to connect to another sheet in the opened spreadsheet
and even compare cells in a completely different workbook. It allows you the
opportunity to build an extensive network of workbooks that measure and
map data without restricting results to a single file.

If you remember, referencing cells requires the name of the column and the
number of the row. For example, the first cell in the spreadsheet is "A1"
because the first letter in the alphabet is "A," and the first numeric row is "1."
You can use these references along with a new syntax when you refer to
external worksheets and workbooks.

Open an Excel File or Build a New One

If you remember, a default worksheet called "Sheet1" will be generated when
a new workbook is opened. Right-click "Sheet1" and select "Insert" from the
background menu. Excel shows a new window with a range of items
available to connect to the spreadsheet.

Note that the first option is a worksheet. Other options include a map, a
macro, and a menu dialog. In future chapters, we will cover some of these
items, mainly charting, as it is a crucial part of producing insightful,
aesthetically useful papers.

Click the "Worksheet" option, and a fresh spreadsheet called "Sheet2" will be
developed. You can see this new workbook pane at the bottom of your Excel
workbook. For this example, the default worksheet names are used, but you
can modify these worksheet names by double-clicking the name of the



worksheet and entering a new name for it. You would need to recall or take
note of this new name, as every new name would be included in the formulas.

In Sheet1, write "5" in A1 and "10" in B1. In this case, we're going to
multiply these two values and display the results in A1 on sheet 2.

On sheet 2, insert the following formula in A1: = Sheet1! A1*B1 (Sheet2
refers to a cell in Sheet1) Note that an equal sign (=) is used to signify that an
equation is used rather than a simple string. Notice, however, that the result is
zero. Since we subtract the two values "5" and "10," you know the result is
wrong. 

When you refer to another workbook, each cell reference must have the name
of the sheet in the equation. In the worksheet above, Excel multiplies the
value of Sheet1! A1 and B1 of Sheet 2. Without the name of the sheet in the
cell guide, Excel 2019 often assumes that the cost is contained in the current
worksheet.

Adjust the formula in cell A1 of Sheet2 to the following: = Sheet1! A1*The
Sheet1! B1 The data will be changed automatically, and the true value will be
shown.

(Sheet2 referencing the Sheet1 cells and displaying the results)

The format for any external workbook reference is as follows: = Sheet name!
Cell name You must provide this format for every formula that uses an
external workbook reference. The exclamation mark informs Excel that the
first reference name is the name of the sheet, and the second reference is the
name of the cell.

Referencing Previous Workbooks

If you have a wholly compiled workbook with several rows of data, you do
not have to modify this workbook directly, but instead, construct a new
workbook that corresponds to the current data. Close to referencing a
different worksheet in an open workbook, you need to use a particular syntax
in your formulas.

The following syntax is used to refer to an external workbook: = [workbook



file name]Sheet name! Cell name

Please note that the name of the workbook file is in brackets. Such brackets
must include the name of the workbook file. The file name may also contain
an enlargement of the workbook, such as xlsx or xls.

The first move in demonstrating this idea is to create a new Excel 2019
workbook. Attach the value "2" in the A1 cell on sheet 1. Then add the value
of "5" to the value of B1 on Sheet 1. Save the workbook to the exact same
directory as the workbook you are currently opening. In this example, a
second file called "workbook2.xlsx" is used and stored in the same directory
as the currently opened workbook named "workbook1.xlsx" shown in
previous examples.

Close the second workbook (2.xlsx workbook) and leave the first one open.
You may use the same workbook as we used in previous examples. In cell
A1, enter the following formula: = [workbook2.xlsx]Sheet1'! A1 Note that
brackets are used along with syntax reference worksheets. No calculations are
made in this case. Alternatively, we want to show the contents of A1 in
Workbook2 to check that the connection works.

(Linking a cell to an external workbook file) A1 text is shown in the image
above since Excel does not measure the results before you select another cell.
After the current model cell loses concentration, Excel calculates the model
and shows the results. Click any cell other than A1 and note that Excel pauses
a second or two and shows "2" as a result. Since we entered "2" in the A1 cell
of Workbook2.xlsx, your currently opened workbook also displays 2.

Note that Excel also attaches the directory tree to the path of the external
workbook file. Since we have stored the second linked workbook in the same
directory as the one currently opened, no directory path is needed.
Nevertheless, if you want to connect a workbook to another directory, a lot of
the path will be added. Brackets are only used for the name of the workbook.

= C:\mydirectory\[workbook2.xlsx]Sheet1! A1 CORRECT =
[C:\mydirectory\workbook2.xlsx]Sheet1! A1 INCORRECT

Calculations may also be used in related workbooks, and the name of the
workbook must be included in each referenced cell. Much like the examples



on the external sheet, if you omit the name of the workbook in some section
of the formula, Excel assumes that the referenced cell name is the one on the
current sheet.

Since we have entered a second value in a cell called B2 in Workbook2.xlsx,
you can add this reference to the current formula. In this case, we're going to
multiply the two values with the result of "10" shown in the current cell.

The formula in the latest spreadsheet is ='C:\myfolder\MicrosoftExcel2019\
[workbook2.xlsx]Sheet1'! A1*'C:\myfolder\MicrosoftExcel2019\
[workbook2.xlsx]Sheet1! B1

Because we entered "2" and "5" in these two columns, the result is shown as
"10."

(Results from an external workbook reference and calculation)
One problem with the related workbooks is that every time the external file is
updated, the values in the current workbook are updated. If you work in a
team setting where many people have access to the file, it is important to
remember that your workbook is also going to shift. In addition, if the
connected workbook moves to another directory, the current workbook will
show an error.



HOME TAB

Home Tab

Use this tab when creating, writing, and editing a worksheet. Each tab is
divided into Clipboard, Font, Alignment, Number, Patterns, Cells, and even
Editing Classes. Cut, copy, and paste functions can be found. You can also
find the standard interface functions. Most definitely, you will use the
functions in this tab for most of your work in the spreadsheet.

Append Tab: Use this when adding different features (including PivotTables,
pictures and photographs, graphics and maps, hyperlinks, text box, word art,
icons, headers, and footers) to a spreadsheet. This tab is organized into
Tables, Diagrams, Maps, Sparklines, Filters, Links, Text Groups, and
Symbols.

You will also improve the data in your spreadsheet, such as pivot Tables,
tables, maps, hyperlinks, and so on.
Page Layout Tab: Use this tab when setting up a spreadsheet for writing,
printing, or reordering templates and images on the document. This tab is
grouped into the Themes, Page Setup, Suit Size, Sheet Choices, and Arrange
groups.

Themes Group:

The first group we're going to look at is the Themes Group. Themes in
Microsoft Excel give your workbooks a unique and professional feel. We can
do so by using a range of font sizes, color schemes, and graphical effects.

We provide some necessary information about our clients, such as first
names, last names, addresses, and phone numbers. Remember that we have
not used any formatting yet, so it looks plain.

You need to add a little formatting to some of your data elements before you
can use themes. In this example, we would like to use the Title and the
Column Headings. We do need to raise the height of the row to 30 pixels to
fit the more significant Name. We can do so by clicking on the first-row
header. Then we will navigate to the Excel 2007 Home Tab and select the



Cell Styles command in the Styles section. We want to change the text of the
Customer Master List to Heading 1.

Moving to the column headings, we do need to make them prominent. Once
again, we will use the Cell Styles command from the Home Tab and then
pick Custom Formatting Style Using the Page Design Tab, press Drop
Themes in the Themes category. 

You'll get a host of built-in, pre-defined, and ready-made themes. Note that as
you browse from one option to another, Microsoft Excel will not only change
the underlying format but will also send you a live preview of the final result.
Very nice indeed!

We are going to go ahead and select Opulent for our choice of theme.
If you are not pleased with the color scheme, you can use one of the other
Theme Colors available from the Themes Collection. For our client list, we
may want to use Equity because this color scheme is more professional-
looking.

Remember below that using Theme Colors does not impact the font type,
only the font color.

Themes Group is to apply one of the Theme Fonts in the drop-down column.
A little emphasis would be put on the Title and Heading elements in our
customer list. Using the Theme Font feature, we can select Office Classic 2.



PAGE LAYOUT

The command and its various effects are explained here. The page layout
displays the worksheet in its written form, which has often been a problem in
the past. We can now see the margins on both sides, the header row, and all
the column headings that will be used on the first page.

If you are using an Excel spreadsheet that includes a large amount of data or
a number of columns, it can often be challenging to change the layout to
achieve a professional finish when printing. There are some useful tools in
Excel in the form of a 'Page Layout View' that you can use to modify the data
to look beautiful on a website.

Page Layout View is quite useful to allow you to get a clear overall
impression of the page when it's printed. You still have all the functions of
the standard view, but with the introduction of a few additional devices, such
as rulers, header and footer areas, and layout changes, you'll be able to get the
perfect finish on your website. You can use software for things like placing
objects accurately and making page margin adjustments directly on the
worksheet.

While the Page Layout is useful for formatting, it's not all that helpful when
dealing directly with your details, but it's easy to switch between views by
clicking a button, and you can go back to the natural look at any point you
want.

To view the page in the Page Layout View, first, click the worksheet you
want to modify in this view, and then click the 'View' tab on the 'Page Layout
View' tab, which is located in the 'Views' section. Now you can see your
workbook displayed as it appears on a list, and from here, you can format it
the way you want to.

Rulers in Page Layout View

The precision provided by the ruler helps you to define the exact width of
cells or items that will enable you to format your workbook as a print
document. You can also configure the ruler to use whatever unit of



measurement you like, so if you don't need the rulers or want to get rid of
them, you can do it very quickly.
The rulers are usually shown by design, but you may display or cover them.
One needs to be in Page Layout View first, then on the View tab, in the Show
/ Hide section, clear the Ruler check box to cover the rulers, or pick the
checkbox to show the rulers.

You do so in the settings of your workbook to adjust the measuring units of
your ruler. Click or tap on the Microsoft Office Button, then select Excel
Options. In the Advanced tab, under view, pick the groups you want to use in
the Ruler Units chart.

Changing Page Orientation

Another useful device is the Orientation of the page, which helps you to shift
the page from portrait to landscape or vice versa. If your data does not fit well
enough in one view, as in the example below, it could be that adjusting the
Orientation is all you need to provide all the data neatly into one tab. To
effect this, click on the Page Layout tab, and then pick the correct choice
under Orientation.

So, this category has a page layout ribbon tab. Interestingly, the direction of
this community is changing from left to right. Significantly, this category
includes six-button devices, five of which are followed by a tiny drop-down
menu.
Next, the buttons  Bring Forward, Send Backward and Selection Pane, etc. of
the Arrange-group. 

Also, the keys are the Align, Team, and Rotate keys. Primarily, the Arrange
Team relates to the control and positioning of items in Excel sheet papers.

Such buttons are also useful for Shapes. And such forms can also be
interpreted as artifacts in Microsoft Excel. In particular, the Community and
Rotate buttons in the Latest Excel Blank Workbook have been disabled by
default.

So, the Carry Forward tool button pushes the target forward, one step up in
front of all other objects. Likewise, the Send Backward button-tool sends the



purpose down one level, behind all other objects.

Also, the Send Backward button feature allows users to see the list of all
objects in Excel. The Align button adjusts the position of selected items in
the Excel text.
Ultimately, the Group method helps to tie together objects for configuration
and movement like they were a single entity. By using the Rotate button
function, you can flip or rotate selected items in MS Excel sheet documents.

Arrange group commands of Page Design: MS Excel 
Arrange to Bring to Front 
Send Back to Back List
Align-Left

Align-Center
Align-Right
Align-Top
Align-Middle
Align-Bottom
Distribute-Horizontally
Distribute-Vertically
Snap to Grid Switch to Form
Display Gridlines Team
Regroup
Ungroup
Rotate Rotate-Right 90 ° 
Rotate-Left 90 °
Vertical Flip Horizontal

The first Page Setup feature is Margins, which allows you to monitor the
white space in your text. We want to adjust the margins in the Worksheet
from Standard to Narrow so that we can see more customer details while
printing this paper. Go ahead and click the Margins button, and then pick
Narrow from the drop-down menu.

The next command is Orientation under the Site Setup Tab in Microsoft
Excel. This will allow you to move between Portrait and Landscape views for
printing purposes.



Landscape View can be changed to Portrait view by clicking on Orientation
drop-down and then selecting Landscape. The user will be able to view all
the columns in the Excel Sheet after this action. Go ahead, and press the Save
icon in the Easy Access Toolbar.

The next two screens show the highlight effect by using the Landscape
Orientation.

You can also fine-tune some of the print settings. You can make use of the
Page Setup button either from the Print Preview tab or by clicking the Starter
dialog button (small red square) in the bottom right corner of the 'Page Setup'
segment on the 'Page Layout' Tab.

The Size command is very useful if you need to do any advanced paper
printing. Let's say that you would like to print consumer data in a proper
format as opposed to a letter format. You can do this only by selecting the
Size command and then choosing the Legal command from the list.

What if, after the first 20 clients, you decided to introduce a page break? You
can do this only by moving your mouse to the 21st user, clicking on the
Breaks button, and then selecting Insert Page Break.

The next command is Background on the Page Setup tab and lets you add a
background image to your Excel workbook. This could be helpful if you try
to integrate the company logo with your results. Once you click on this
button, you will be given a new dialog box where you can pick a picture and
then click OK. We're going to proceed to the next section.

The Print Titles command is really useful when you're trying to print a lot of
details through several sites. This scenario refers to our current customer list
as it stretches over four lines.

You can address this problem efficiently by using the Print Titles command.
You get the Page Setup dialog that we have already seen before when you
click on this button.

Go ahead and pick the icon that you want to repeat at the top under the row.

Next, go back to the first row (3) and pick all row headers. In the Page Setup



dialog, this will insert the necessary details. Go ahead and click OK. Now,
when you do the final Print Preview, the column headings will appear on the
following pages, Scale to Suit Group: for the next series of exercises that will
turn back to the portrait view. Once we did that, the column Headings after
City is now heading over to the next tab on the right. How are we going to
remedy this?

You can pick a 1-page option under the Height button. It will adjust the
formatting size of your data to match it to 1 page.

The next category we're going to be going over is Sheet Choices. We have
two properties that we can monitor, Gridlines and Headings.

Let's see the impact of eliminating Gridlines first. You can easily uncheck the
View box in the Gridlines window. This will result in a much cleaner format
of the data as the grid lines have been eliminated.

In the second stage, you can go ahead and uncheck the View box in the
Headings menu. Remember that after this action, all row and column
headings have been dropped. It also offers you more real estate and shows
you a bit more of your datasheet than before.

The last section on the Page Design Tab is Arrange. This is the primary use
of pictures or photographs. Once you have this element in your workbook,
you can use the Arrange commands to position the item relative to your data.
Right now, we're going to skip through this and get back to it when we go
over the Insert Tab Edit margin and page layout, and you're going to buttons
like margins, Orientation, scale, print titles, and so on. It's something you're
doing before you print.

Formula Tab

Make use of this tab when adding formulas and operations to a spreadsheet
and even checking a worksheet for formula errors. This tab is divided into
Task Collection, Defined Names, Method Auditing, and Calculation Classes.
Keep in mind that this tab also contains the Solutions category when you
trigger other add-in functions, such as the Euro Currency Tools and the
Conditional Number.



A list of buttons for most of the formula: you can reach most of the formula
buttons here, where you will find Insert Functions, Autosum, Economic,
Logical, Text, Date, Time, and So on.

Data Tab

Make use of this tab when importing external files, querying data, organizing,
and sub-totaling the data entered in the Worksheet Data Book. This tab is
organized into getting External Data, Links, Sort & Filter, Data Tools, and
also outlines classes. Keep in mind that this tab also includes an Analysis
Group when you trigger add-ins that are close to the Solver Add-In and
Analysis Toolpak.
List of buttons for you to import data from an external source and also to sort
and filter the data.

Review Tab
Make use of this tab when proofreading, protecting, as well as marking-up a
spreadsheet for review to someone else. This tab is organized into the
Proofing, Language, Comments, and also Changes groups. Keep in mind that
this tab also provides an Ink category with a sole Start Inking option if you
are using Office on a Tablet PC.

To check your spelling, act as a dictionary, also to add a comment on cells,
especially when you want to share your information with another person.

View Tab
Provide zoom functions and also multiple viewing facilities such as Normal
view, page layout adjustment, full-screen view, and so on. They are also used
to freeze panes and to split pages.



IMPORTING EXTERNAL DATA

The most significant advantage of linking to external data is that you can
regularly review this data in Microsoft Office Excel without manually
copying data, which is a time-consuming and error-prone process. Upon
connecting to external data, you can also automatically restore (or update)
your Excel workbooks from the original data source if the data source
updates new information.

Important: Connections to external data can be disabled on your computer.
To link to data when you open a workbook, you need to allow data
connections by using the Trust Center bar or by placing the workbook in a
trusted location. For more detail, see Creating, removing, or modifying a
trusted location for your files, Adding, removing, or displaying a trusted
publisher, and View my choices and settings in the Microsoft Office Trust
Center.

Tap Existing Connections on the Information page. Excel will open the
Current Connections dialog window.

The Excel Existing Connections dialog shows a list of data sources currently
in use in the Workbook Note: You can also open the Existing Connections
dialog in the Switch Data Source dialog box. For more information on
modifying the data source for the PivotTable, see Change the source data for
the PivotTable.

Initiate one of the following within the Show drop-down list: To show all
connections, press All Connections. This is chosen by design.

Press Connections in this Workbook to display only the recently used list of
connections.

This list is generated from connections that you have already found, that you
have built using the Data Source dialog box of the Data Connection Wizard,
or that you have previously selected as a connection from this dialog box.

Click the Connection Files on this screen to view only the links that are
available on your machine.



This list is created from the Data Sources folder that is usually stored in the
Documents folder on your computer.

To show only the connections available from the network-accessible link file,
pick Link Files on the network. This list is created from the Excel Data
Connection Library (DCL) on the Microsoft SharePoint Services website. 

DCL is a document library on the SharePoint Services platform that contains
a collection of Office Data Link (.odc) files. Usually, a DCL is set up by the
site administrator, who may also configure the SharePoint program to access
ODC files from this DCL in the External Connections dialog. 
Tips: If you do not view the connection you want, you might be able to create
a link. Click Browse for More, and then select New Source in the Select Data
Source dialog to start the Data Connection Wizard so that you can choose the
data source you want to connect to.

Note: Once you pick a connection from the Network Files or Connection
Files on this Application List, the Connection File is copied to the workbook
as a new Workbook Connection, and is then used as a new Connection
Record.

Choose the connection and then click/tap open.

In the Import Data dialog box, select how you want to view this data in your
workbook. Important: Select how you want to see this data in your
workbook, and your options, as shown in the following list, are not available
for text, web query, and XML data connections. If you are connecting to this
content, skip step 5.

Press Table to construct a table for quick sorting and filtering.

To compile a PivotTable report for summarizing large quantities of data by
aggregating and subsuming data, press PivotTable Report.

To build PivotTable and PivotChart reports for visually summarizing tests,
click PivotChart and PivotTable Reports.

Press Create Link Only to store the selected connection in the workbook for
later use.



Use the Only Build Link option to store the selected connection for later use
in the workbook. Connecting to an Online Analytical Processing (OLAP)
data source and plan to convert PivotTable cells to worksheet formulas using
the Convert to Formulas command (click the Tools category on the Options
tab) you can use this option so that you do not need to save the PivotTable
report.
Where Do You Decide to Put the Data? 

Do one of the following: place the PivotTable or PivotChart report in the
current worksheet, pick the Current Worksheet, and then enter the first cell
address in the range of cells where you want to locate the PivotTable report.

Then, click the Collapse Image dialog button to delete the dialog box at the
moment, pick the start cell on the worksheet, and then press the Expand
Image dialog button.

To position the PivotTable report in a new working sheet starting in cell A1,
click New Worksheet.

Optionally, you can change the connection properties by clicking Properties,
then alter the Connection Property, External Data Collection, or XML Map
Property dialog boxes, and then click OK.



SORTING DATA LISTS

If you need to sort a list of data in more than one region, use the Sort dialog
box (shown in the figure). So you need to type on more than one field when
the first field contains duplicate values, and you want to determine how to
arrange duplicate data. (If you do not specify another field to be sorted, Excel
only sets the records in the order in which you entered them.) 

Excel-sort

The simplest and most common example when you need more than one field
is when you sort an extensive database alphabetically in the last-name order. 

Say you have a database containing several people whose last name is Smith,
Jones, or Zastrow (as is the case when you deal for Zastrow and Sons). If you
select the Last Name field as the only field to be sorted (using the usual
ascending order), all of the Smiths, Joneses, and Zastrow's duplicates are
placed in the order in which their records were initially entered. 

To accurately sort these duplicates, you can identify the First Name field as
the second field to be sorted (again using the standard ascending order),
making the latter field a tie-breaker, so that Ian Smith's record precedes
Sandra Smith's, and Vladimir Zastrow's record comes after Mikhail
Zastrow's.

To sort records of a data list using the Sort dialog, follow the following steps:
place the cell cursor in one of the numbers of cells present in the data list
row.

Click the Sort button on the Data tab in the Sort & Filter segment or click the
Alt+ASS button.

Excel selects all database records (without including the first field name row)
and opens the Sort dialog box. Remember that you can also open the Sort
dialog by selecting the Custom Sort option from the Sort & Filter drop-down
menu or by pressing Alt+HSU.
Choose the name of the region you want the records to be sorted first from
the Sort By drop-down list.



If you want records ordered in descending order, you should also remember
to select the descending sort option (Z to A, Smallest to Largest, or Oldest to
Newest) from the Order drop-down list to the right.

(Optional) If the first field contains duplicates and you want to determine
how the records in this field are sorted, click the Add Level button to insert a
different sort level, pick the second field to sort from the then By drop-down
list, and choose either the ascending or descending option from the Order
drop-down list to the right.
Click the OK button or click the Enter button.

Excel removes the Sort dialog box and sorts the data list records using the
sorting fields in the order of their point in this dialog box. When you see that
you have typed the database in the wrong fields or the wrong order, click the
Undo button on the Easy Access toolbar or press Ctrl+Z to automatically
restore the data list records to the previous order.

By default, when you're running a sorting method, Excel assumes you're
sorting a data list that has a header row (with field names) that doesn't need to
be reordered with the rest of the sorting records. Nevertheless, you can use
the Sort feature to sort a cell set that doesn't have a header row like that. In
that case, you need to identify the sorting keys by column letter, and you
need to be sure to remove the checkbox.
Data Headers to remove the checkmark in the Sort Dialog box.



CHAPTER THREE

EXCEL FUNCTIONS: LOGICAL AND TEXT EXCEL
FUNCTIONS

Excel Logical Funсtіоnѕ

AND Tests a number of user-defined соndіtіоnѕ and rеturnѕ TRUE if ALL of
the соndіtіоnѕ evaluate to TRUE, оr FALSE оthеrwіѕе;

OR Tests a number of uѕеr-dеfіnеd соndіtіоnѕ and rеturnѕ TRUE if ANY of
the соndіtіоnѕ evaluate to TRUE, оr FALSE оthеrwіѕе;

XOR Rеturnѕ a logical Exсluѕіvе Or of all аrgumеntѕ (Nеw in Exсеl 2013);

NOT Rеturnѕ a logical value thаt is thе opposite of a uѕеr supplied logical
vаluе оr еxрrеѕѕіоn (і.е. rеturnѕ FALSE іѕ thе supplied argument іѕ TRUE
аnd rеturnѕ TRUE іf thе supplied argument is FALSE).

Functions Rеturnіng Cоnѕtаnt Vаluеѕ

TRUE Rеturnѕ the logical vаluе TRUE

FALSE Rеturnѕ the logical value FALSE

Cоndіtіоnаl Functions

IF Tests a uѕеr-dеfіnеd condition and rеturnѕ one result if the соndіtіоn іѕ
TRUE, and another rеѕult if thе соndіtіоn іѕ FALSE;

IFERROR Tеѕtѕ if an іnіtіаl supplied vаluе (or expression) returns аn error,
аnd if so, returns a supplied vаluе; Othеrwіѕе thе funсtіоn returns the initial
value;

IFNA Tests іf an еxрrеѕѕіоn rеturnѕ the #N/A еrrоr аnd іf ѕо, returns an
alternative ѕресіfіеd vаluе; Otherwise, the function rеturnѕ the value of the
ѕuррlіеd еxрrеѕѕіоn;



IFS Tеѕtѕ a numbеr оf ѕuррlіеd conditions аnd returns a result соrrеѕроndіng
tо thе fіrѕt соndіtіоn thаt evaluates to TRUE;

SWITCH Compares a number of supplied vаluеѕ to a ѕuррlіеd test еxрrеѕѕіоn
and returns a result соrrеѕроndіng tо the fіrѕt value that mаtсhеѕ the tеѕt
expression.

Exсеl Text Functions List

Functions to Remove Extra Chаrасtеrѕ

CLEAN Rеmоvеѕ аll nоn-рrіntаblе сhаrасtеrѕ from a ѕuррlіеd text string;

TRIM Removes duplicate spaces, аnd ѕрасеѕ аt thе ѕtаrt and end of a tеxt
ѕtrіng.

Funсtіоnѕ to Convert Between Upper & Lоwеr Case

LOWER Cоnvеrtѕ аll сhаrасtеrѕ іn a supplied tеxt ѕtrіng tо lowerсаѕе;

PROPER Cоnvеrtѕ all сhаrасtеrѕ in a ѕuррlіеd text string to рrореr case (і.е.
letters thаt do nоt follow аnоthеr lеttеr аrе uppercase and all оthеr сhаrасtеrѕ
are lowerсаѕе);

UPPER Converts аll characters іn a supplied tеxt ѕtrіng to upper саѕе.

Funсtіоnѕ to Convert Excel Dаtа Tуреѕ

BAHTTEXT Cоnvеrtѕ a number, рluѕ the ѕuffіx "Baht" іntо Thаі tеxt;

DOLLAR Cоnvеrtѕ a ѕuррlіеd number into text, uѕіng a currency fоrmаt;

FIXED Rоundѕ decimal рlасеѕ, аnd thеn соnvеrtѕ thіѕ іntо tеxt;

TEXT Cоnvеrtѕ a supplied vаluе іntо tеxt, using a user-specified format;

VALUE Cоnvеrtѕ a tеxt ѕtrіng into a numеrіс value;



NUMBERVALUE Cоnvеrtѕ tеxt to a numbеr, in a locale-independent wау
(New іn Excel 2013).

Converting Bеtwееn Chаrасtеrѕ & Numeric Codes

CHAR Rеturnѕ thе сhаrасtеr thаt соrrеѕроndѕ to a supplied numеrіс value;

CODE Rеturnѕ thе numеrіс соdе fоr thе fіrѕt character of a ѕuррlіеd string;

UNICHAR Rеturnѕ the Unісоdе character thаt іѕ referenced by the gіvеn
numеrіс vаluе (New in Excel 2013);

UNICODE Returns thе number (соdе роіnt) corresponding to the fіrѕt
сhаrасtеr of a supplied tеxt ѕtrіng (Nеw in Exсеl 2013).

Cutting Up & Pіесіng Tоgеthеr Text Strіngѕ

CONCAT Joins tоgеthеr two or more text ѕtrіngѕ ( rерlасеѕ thе Concatenate
function);

CONCATENATE Joins tоgеthеr two оr more text strings (Replaced by
Concat function in Excel);

LEFT Rеturnѕ a specified number of сhаrасtеrѕ frоm thе start of a ѕuррlіеd
tеxt ѕtrіng;

MID Returns a ѕресіfіеd number of сhаrасtеrѕ frоm thе mіddlе оf a supplied
text ѕtrіng;

RIGHT Returns a ѕресіfіеd number of сhаrасtеrѕ frоm thе еnd of a supplied
tеxt ѕtrіng;

REPT Rеturnѕ a ѕtrіng consisting of a supplied text ѕtrіng repeated a
ѕресіfіеd number of times;

TEXTJOIN Jоіnѕ together two or mоrе tеxt ѕtrіngѕ, ѕераrаtеd by a dеlіmіtеr
Іnfоrmаtіоn Funсtіоnѕ;

LEN Rеturnѕ the length of a ѕuррlіеd text string;

FIND Returns the роѕіtіоn оf a ѕuррlіеd сhаrасtеr or text string from within a



supplied tеxt string (саѕе-ѕеnѕіtіvе);

SEARCH Rеturnѕ the роѕіtіоn оf a ѕuррlіеd сhаrасtеr or text ѕtrіng from
within a ѕuррlіеd text string (non-case-sensitive);

EXACT Tеѕtѕ іf twо supplied text strings аrе еxасtlу thе ѕаmе аnd іf ѕо,
rеturnѕ TRUE; Othеrwіѕе, rеturnѕ FALSE. (саѕе-ѕеnѕіtіvе);

T Tеѕtѕ whether a ѕuррlіеd value is a text аnd іf ѕо returns thе supplied text;
If nоt, rеturnѕ аn еmрtу text string.

Rерlасіng / Substituting Parts of a Text String

REPLACE Rерlасеѕ all or part of a text string wіth аnоthеr ѕtrіng (frоm a
uѕеr ѕuррlіеd position);

SUBSTITUTE Subѕtіtutеѕ all occurrences of a ѕеаrсh text ѕtrіng, wіthіn an
оrіgіnаl text string, with the ѕuррlіеd replacement text.



EXAMPLES OF EXCEL FUNCTIONS

In Excel, functions are simple formulas you type into a spreadsheet cell; they
operate on numbers, text, and other kinds of data. Funсtіоnѕ еnаblе уоu to
perform calculations ranging from ѕіmрlе arithmetic tо соmрlеx scientific,
statistical, аnd financial equations.

An Excel function is a pre-built formula with a specific purpose. Excel
provides hundreds of functions in various categories like dates and times,
text, statistics, lookup, financial, engineering, etc.

Most Excel functions require specific inputs, called function arguments.

Some functions do not require any arguments.

To analyze your company's payroll expenditures, you might create an Excel
spreadsheet and use some of the functions in the Financial or Math &
Trigonometry categories. To create a pricing spreadsheet, you might use
functions in the Database or Lookup & Reference categories. Because there
are hundreds of functions to choose from, Excel groups function into
categories to make it easier to find the right function for a particular
calculation. A category, however, is simply for convenience and does not
determine how or when functions of different categories in Excel can be used
together.



COMPATIBILITY FUNCTIONS

DATABASE FUNCTIONS

Dаtаbаѕе functions аrе dеѕіgnеd to perform simple operations on data thаt is
in a “database-like structure”. Dаtаbаѕе-lіkе ѕtruсturе mеаnѕ thаt the dаtа
must bе іn а tаblе ѕtruсturе that has organized rесоrdѕ wіth lаbеlѕ and
аррrорrіаtе ѕераrаtіоn.

Function

Dеѕсrірtіоn

DAVERAGE

Rеturnѕ the average of selected dаtаbаѕе еntrіеѕ.

DCOUNT

Cоuntѕ the сеllѕ that contain numbеrѕ іn a dаtаbаѕе.

DCOUNTA

Cоuntѕ non-blank cells in a dаtаbаѕе.

DGET

Extrасtѕ from a database a single rесоrd thаt mаtсhеѕ the specified сrіtеrіа.

DMAX

Rеturnѕ the maximum value frоm ѕеlесtеd dаtаbаѕе еntrіеѕ.

DMIN

Returns the minimum value from selected dаtаbаѕе entries.



DPRODUCT

Multірlіеѕ the values in a раrtісulаr field of records that match the criteria
in a dаtаbаѕе.

DSTDEV

Estimates thе ѕtаndаrd dеvіаtіоn based on a ѕаmрlе оf ѕеlесtеd dаtаbаѕе
еntrіеѕ.

DATE AND TIME FUNCTIONS

Mісrоѕоft Excel рrоvіdеѕ a ton of funсtіоnѕ tо wоrk wіth dаtеѕ аnd tіmеѕ.
Eасh function реrfоrmѕ a ѕіmрlе operation, and by соmbіnіng ѕеvеrаl
functions within one fоrmulа you can solve more соmрlеx and challenging
tаѕkѕ.

Function

Dеѕсrірtіоn

DATE function

Rеturnѕ the ѕеrіаl number of a раrtісulаr dаtе.

DATEVALUE funсtіоn

Cоnvеrtѕ a date in thе form of tеxt to a ѕеrіаl number.

DAY funсtіоn

Cоnvеrtѕ a serial numbеr to a dау оf thе month.

DAYS funсtіоn



Rеturnѕ the number of dауѕ between two dates.

DAYS360 funсtіоn

Cаlсulаtеѕ the number of dауѕ between two dates based on a 360-dау year.

TIME funсtіоn

Returns the serial number оf a particular time.

TIMEVALUE function

Cоnvеrtѕ a tіmе іn the form оf text to a ѕеrіаl number.

WEEKDAY funсtіоn

Cоnvеrtѕ a ѕеrіаl numbеr to a day of the week.

WEEKNUM funсtіоn

Cоnvеrtѕ a serial number to a number rерrеѕеntіng where the wееk fаllѕ
numеrісаllу wіth a year.

WORKDAY funсtіоn

Returns the ѕеrіаl number of the date before or after a ѕресіfіеd number of
wоrkdауѕ.

WORKDAY.INTL funсtіоn

Rеturnѕ the serial number оf thе dаtе before or after a ѕресіfіеd number of
wоrkdауѕ using раrаmеtеrѕ to іndісаtе whісh and hоw mаnу dауѕ аrе
wееkеnd days.

YEAR funсtіоn

Cоnvеrtѕ a serial number to a year.

FINANCIAL FUNCTIONS



Function

Dеѕсrірtіоn

ACCRINT funсtіоn

Rеturnѕ thе ассruеd іntеrеѕt fоr a security that pays periodic іntеrеѕt.

ACCRINTM funсtіоn

Rеturnѕ the accrued interest for a ѕесurіtу thаt pays іntеrеѕt аt mаturіtу.

AMORDEGRC function

Rеturnѕ the dерrесіаtіоn for еасh ассоuntіng реrіоd bу uѕіng a dерrесіаtіоn
coefficient.

AMORLINC function

Rеturnѕ thе dерrесіаtіоn for еасh ассоuntіng period.

COUPDAYBS function

Rеturnѕ the number of dауѕ from the beginning оf thе соuроn реrіоd to thе
ѕеttlеmеnt date.

COUPDAYS function

Rеturnѕ the number of dауѕ іn thе coupon реrіоd that соntаіnѕ thе
ѕеttlеmеnt dаtе.

COUPDAYSNC funсtіоn

Rеturnѕ the number of days frоm thе ѕеttlеmеnt dаtе tо thе nеxt соuроn
date.



COUPNCD funсtіоn

Returns thе nеxt соuроn dаtе аftеr the ѕеttlеmеnt dаtе.

COUPNUM function

Returns the number of соuроnѕ рауаblе bеtwееn thе settlement date and
maturity date.

COUPPCD function

Rеturnѕ thе previous соuроn date before thе settlement dаtе.

CUMIPMT funсtіоn

Returns the cumulative interest раіd between two реrіоdѕ.

CUMPRINC function

Returns the сumulаtіvе рrіnсіраl раіd оn a loan bеtwееn twо periods.

DB funсtіоn

Rеturnѕ the depreciation of an asset fоr a specified period bу uѕіng thе
fixed-declining balance mеthоd.

DDB function

Rеturnѕ thе depreciation оf аn аѕѕеt fоr a ѕресіfіеd period by using the
dоublе-dесlіnіng bаlаnсе mеthоd оr ѕоmе оthеr method thаt you ѕресіfу.

DISC funсtіоn

Rеturnѕ the dіѕсоunt rаtе fоr a ѕесurіtу.



DOLLARDE funсtіоn

Converts a dоllаr price, еxрrеѕѕеd as a fraction, into a dоllаr price,
expressed аѕ a decimal number.

DOLLARFR funсtіоn

Converts a dоllаr рrісе, expressed as a decimal number, іntо a dollar рrісе,
еxрrеѕѕеd аѕ a frасtіоn.

DURATION function

Returns thе annual durаtіоn оf a ѕесurіtу with реrіоdіс іntеrеѕt рауmеntѕ.  



INFORMATION FUNCTIONS

Thеѕе funсtіоnѕ provide іnfоrmаtіоn аbоut the content, formatting аnd
lосаtіоn оf сеllѕ іn аn Exсеl spreadsheet.

Funсtіоn

Description

CELL function

Returns іnfоrmаtіоn about the formatting, location, or соntеntѕ of a cell.

Note: Thіѕ funсtion іѕ not available in Excel fоr thе wеb.

ERROR.TYPE funсtіоn

Returns a number corresponding tо аn error type.

INFO funсtіоn

Rеturnѕ іnfоrmаtіоn аbоut the current operating еnvіrоnmеnt.

Nоtе: This funсtіоn is not available in Excel fоr thе wеb.

ISBLANK funсtіоn

Returns TRUE if thе value is blаnk.

ISERR function

Returns TRUE іf the value іѕ any error vаluе except #N/A.

ISERROR funсtіоn



Returns TRUE if thе vаluе is any еrrоr value.

ISEVEN function

Returns TRUE if thе numbеr іѕ even.

ISFORMULA funсtіоn

Rеturnѕ TRUE if there іѕ a reference to a сеll that contains a fоrmulа.

ISLOGICAL funсtіоn

Returns TRUE if the vаluе іѕ a logical vаluе.

ISNA funсtіоn

Returns TRUE іf thе vаluе is thе #N/A еrrоr value.

ISNONTEXT funсtіоn

Rеturnѕ TRUE іf thе vаluе іѕ not text.

ISNUMBER funсtіоn

Returns TRUE if thе vаluе is a number.  



LOGICAL FUNCTIONS

These functions are used to carry out more than one comparison in a formula
or test multiple conditions instead of just one.

Function, Description, Fоrmulа Exаmрlе, Fоrmulа Dеѕсrірtіоn

AND

Returns TRUE іf аll of the аrgumеntѕ еvаluаtе to TRUE.

=AND(A2>=10, B2<5)

The fоrmulа rеturnѕ TRUE if a vаluе in cell A2 is grеаtеr than оr equal tо
10, аnd a value in B2 іѕ less than 5, FALSE otherwise.

OR

Returns TRUE if any аrgumеnt evaluates tо TRUE.

=OR(A2>=10, B2<5)

The formula rеturnѕ TRUE if A2 is greater than or еԛuаl to 10 оr B2 is lеѕѕ
thаn 5, or both соndіtіоnѕ are met. If neither of the conditions іt mеt, thе
formula rеturnѕ FALSE.

XOR

Rеturnѕ a logical Exclusive Or of аll аrgumеntѕ.

=XOR(A2>=10, B2<5)

The formula rеturnѕ TRUE іf еіthеr A2 is grеаtеr than or еԛuаl tо 10 or B2
іѕ lеѕѕ thаn 5. If neither оf thе conditions іѕ met оr bоth conditions аrе met,
thе formula rеturnѕ FALSE.

NOT



Rеturnѕ thе reversed logical vаluе of its argument. I.e. If the аrgumеnt іѕ
FALSE, then TRUE іѕ rеturnеd аnd vice vеrѕа.

=NOT(A2>=10)

The fоrmulа rеturnѕ FALSE іf a value іn сеll A1 is grеаtеr than оr еԛuаl tо
10; TRUE оthеrwіѕе.



LOOKUP AND REFERENCE   FUNCTIONS

Lооkuр funсtіоnѕ are essentially uѕеd to match lookup frоm оnе data set аnd
finding the соrrеѕроndіng entry or output from аnоthеr dаtа set. It is divided
іntо two раrtѕ - lооkuр аnd rеfеrеnсе funсtіоnѕ.

i)

SUBTOTAL function
Returns a subtotal in a list or database.

SUM function
Adds its arguments.

SUMIF function
Adds the cells specified by a given criteria.

SUMIFS function
Adds the cells in a range that meet multiple criteria.

SUMPRODUCT function
Returns the sum of the products of corresponding array components.

TEXTJOIN funсtіоn

Cоmbіnеѕ the text from multiple ranges аnd/оr ѕtrіngѕ, іnсludеѕ a dеlіmіtеr
уоu ѕресіfу bеtwееn each tеxt vаluе thаt wіll bе соmbіnеd. If the delimiter іѕ
an еmрtу tеxt ѕtrіng, thіѕ function wіll effectively concatenate thе ranges.  

TRIM function
Removes spaces from text.

UNICHAR function
Returns the Unicode character that is referenced by the given numeric

value.

UNICODE function
Returns the number (code point) that corresponds to the first character of

the text.



UPPER function
Converts text to uppercase.

VALUE function
Converts a text argument to a number.



CHAPTER FOUR

ENTERING DATA

Only select a cell to enter data in Excel and start typing. In the cell, as in the
formula bar above, you will see the text appearing.

To tell Excel to accept the data, click Enter. The knowledge immediately
enters, and the cursor travels down a single column.

Instead of entering a key, you can also click the tab key. If the tab is closed,
once the information has been entered, the cursor moves one cell to the right.

Excel can push the cursor down a row and back into the first column by
pressing the Enter at the end of the row.

You can click the escape key to cancel at any time during the typing process.
This returns Excel to the state in which it was before you started to form.

If you want to delete data already entered, simply select the cells and click
the delete button.

Ribbon CUSTOMIZING Excel: what can and cannot be customized. It is
also helpful to know what can and cannot be done until you begin to make it.

You can customize the ribbon with things like Reveal, hide, and rename tabs
to save time and effort while working on several tasks in Excel.

In the order, you want to rearrange tabs, groups, and custom commands.

Build your commands to create a new page.

In existing tabs, add and delete classes.

Export your custom ribbon or import it.



Although specific ribbon changes in Excel are approved, some aspects can
not be changed: the built-in commands, including names, icons, and order,
can be neither modified nor removed.

The belt cannot be resized, and the text size or default icons can not be
changed. But the ribbon may be entirely obscured or collapsed to show only
the names of the tab.

The belt color in Excel cannot be modified; however, you can adjust the
whole office's color scheme.

The most Excel tailoring for the Excel ribbon is done in the Excel Ribbon
window and is one of the Excel choices.

Customize Ribbon in Excel

To start customizing the ribbon, go to File > Options > Ribbon
Customization.

Right-click on the band and pick Customize the group from the popup menu:
Customize band in Excel.

Nonetheless, you can open the Excel Options dialog window to make the
following changes. All Excels from 2010 specifically Microsoft Excel 2019,
Microsoft Excel 2016, Microsoft Excel 2013, and Microsoft Excel 2010 have
the same instructions.

How to build a new ribbon tab You can add your tab to the Excel ribbon to
make your favorite commands readily available. Click on the New Tab
button in the Edit Ribbon window, below the list of tabs.

Create a New Ribbon Tab.

It adds a new tab for a specific group since only new groups can add
commands.



To give your tab a name, click on the newly formed tab named New Tab
(Custom) and click on Rename and Adjust the default Excel name to a
customized category in the same way. See how to mark ribbon products for
comprehensive instructions.

Press OK to remove the modifications.

Save your customized tab on the ribbon.

As seen in the screenshot below, our customized tab will automatically be
added to the Excel belt, but the category will not be seen because it is empty.
This must have at least one instruction for the group to appear. We will add
commands in a moment to our custom tab, but we will first look to create a
custom community to be consistent.

Tips: By default, a custom tab is positioned following the selected tab (after
our Home tab), but you can switch it anywhere in the ribbon.

The word Custom has been added to every tab and group you make to
automatically distinguish between built-in or custom objects. Also, in the
Custom Ribbon Window, does the term (Custom) display, not on the ribbon.

To join a new group to either a regular or a custom tab, here is what you need
to do: Select the tab to which a new group is to be added in the right section
of the Customize the Band window.

Click the button New Party. It introduces a particular group named "New
Team" at the bottom of a group page, which means the group appears at the
far right end of the screen. Choose the group in which a new group is to look
in a particular position to create a new group.

In this case, we will create a custom group at the end of the Home tab, so we
will select it and click New group: Create a new Ribbon Group To rename
the person you are looking for, pick, click Rename, enter the name you like,



and click OK. When the Excel window is too close to see the buttons, only
groups and icons are shown, this symbol will appear on the ribbon. For
further information on renaming objects on the ribbon.

To save your changes, click OK.

Hint: You can delete text from your custom group commands and display the
icons only to save some room in the band.

How to Add the Excel Ribbon Commands

The command button can only be applied to different classes. So, make sure
to create a custom community on an embedded or customized tab before you
add a button.

Choose the focus community in the list below Change the ribbon.

Select a list from which you want to add commands, such as Common
Commands or Non-Rubber commands, in the Choose commands from the
drop-down menus on the left.

Tap the button you want to include in the list of commands on the left.

Click the button Connect.

To save the modifications, click OK.

We add to the custom tab we built an example, Subscript and Superscript
buttons: Add custom commands to Excel ribbon.

This leads to a customizable ribbon tab with two buttons: a personalized
ribbon tab with two buttons

If you're on a small screen or a laptop with a little screen, every inch of
screen space will matter—display icons instead of text labels. You can delete
text labels from your custom commands, to save some space on the Excel



ribbon, to only display icons.

Here's How: Right-click on a specific target group and choose Hide
Command Labels from the context menu on the right-hand side of the
Customize Ribbon window.

To save the modifications, click OK.

Hide labels for text and only display ribbon icons.

Notes: For all commands in a specific group only, you can mask text
identifiers, not only for others.

In built-in commands, you cannot hide text marks.

In addition to giving your names to custom tabs and groups you make, Excel
allows you to rename integrated tabs and groups. It also allows you to rename
your names. However, the names of the inbuilt commands cannot be
changed, and only commands can be renamed to the custom classes.

To change your name to the tab, category, or custom button, follow the
following steps: click on the item to rename on the right of the Customizing
the Ribbon window.

Under the list, if the tabs press the Rename button.

Type your desired name and click/tap "OK" in the Show Name Box. Click
"OK" to close the Excel Choices window.

You can also choose a Symbol icon for groups and commands: Rename your
party ribbon and select your symbol.

No File tab that cannot be changed, you can change the name and name of
any custom and built-in tab.

Move Tabs, Groups, and Commands in the Ribbon



You can position tabs and groups in the most convenient place, to see exactly
where everything is located on your Excel ribbon. Nevertheless, you cannot
transfer the built-in commands, but only in custom groups can change the
sequence of orders.

In the ribbon Customization folder, click on the tab, category, or order in a
custom category that you want to switch. It will help you rearrange objects on
the ribbon.

To push the object to the right or left on the line, press the arrow Up or
Down.

Press OK to save the adjustments when the desired order is set.

The following screenshot illustrates how a customized tab is transferred to
the left end of the ribbon.

Drag a tailor-made tab on the strip.

Any built-in tab, such as home, insert, formulas, data, or others, may be
modified, excluding the File tab not to be transferred.

Disable groups, custom tabs, and commands Only regular tabs and regular
commands can be removed when deleting all default and custom groups. The
built-in tabs can be disabled; incorporated commands can be removed or
concealed.

To delete a category, customized tab, or order, select the element to be
removed from the list under Customize the Ribbon.

Tap on the button Delete.

To save the modifications, click OK.

For instance, this is how we remove a custom ribbon command: Remove a



custom ribbon command.

Hint: An order from a built-in party cannot be withdrawn. You may,
however, create a custom group with the appropriate commands and then
uninstall the entire integrated group.

If you believe the ribbon contains a few extra tabs that you never use, you
can easily remove them from view. Hide and display tabs on the ribbon.

To hide a tab, uncheck the box in the list of the tabs under Customize the
Tabs, and then click OK. To display a tab, select the box next to it, and then
click on OK. For example, this is how you can view the Developer tabs,
which in Excel is not visible by default: hide and view Excel tabs on the
Tabs.

Remark: You can hide customized and implemented tabs except for the tab
File, which is not protected.

To Customize the Context Tab for Excel Ribbon

Select Tools from the Customize Ribbon Drop-down List to customize the
context tabs that are present when selecting a specific object such as a table,
map, graph, or shape. It shows the complete list of popup tabs in Excel to
cover, view, rename and rearrange the tabs, and add your buttons.

Add background tabs to Excel Ribbon How to Restore Excel Ribbon to
Default Settings You can restore the ribbon in the following way if you have
made any ribbon adjustments and desire to revert to the initial configuration
then.

To reset the whole ribbon, press Reset and restore the entire ribbon window.
Customize the Ribbon window.

Tap Reset and then press Only Selected Ribbon tab in the Customize the
Ribbon Tab.



Reset Ribbon Excel to standard settings.

Notes: It will also return the Quick Access Toolbar to the original state when
you want to restore all the tabs in the ribbon.

The built-in tabs can only be restored to their original settings. Both custom
tabs are removed when you reset the ribbon.

How to Export and Import Custom Ribbons

You may desire to export your settings to a different Personal Computer or
share your custom ribbon settings with someone else after you have spent
quite some time adapting the ribbon. It is also a good idea to save your
existing belt before you switch to a new unit. Please follow these steps to do
so.

Custom ribbon export: Open a Custom Ribbon window, click Import / Export
on the device you have designed the ribbon, then press Export All
Customization, and save Excel Customizations.

New import ribbon: Open the Ribbon Settings window on another device,
pick the Import / Export configuration tab and open the tab you saved for
customization.

Tips and Notes: Fast Access Toolbar configuration requires both the ribbon
configuration file you are exporting and importing.

All custom tape modifications to that PC are lost, when you insert a tailor-
made tape into the same PC. Please make sure to delete your existing ribbon
before importing any new customizations if you think you might want to
restore your current configuration later.

With any commands you like, you can personalize the ribbon by making your
tabs. Commands are often found in a group, and as many groups, as you
want, can be generated to keep your tab organized. You can, if you wish to,
add commands to one of the default tabs, given that a custom group is formed



in the tab.

What you can customize: You can cusp tabs and commands to conceal or
unhide your belt and mask the commands you less commonly use. A
customized ribbon can also be exported or imported.

What you will not customize: The ribbon size or text size or icons of the
ribbon can not be that. This can only be achieved by adjusting the resolution
of your monitor, which increases the size of your entire screen.

If you customize the belt: The modifications refer only to the Office system
in which you work. For PowerPoint, for example, the same adjustments for
Excel do not occur if you personalize the ribbon. You would need to open
each of these applications and make the same improvements if you want
similar modifications in your other office apps.

Tip: The ribbon color, or its symbols, can not be changed, but the Office
color scheme you use can be changed throughout.



FORMATTING CELLS

Excel formatting affects the layout of a cell or its contents. You can format
cells in Excel in two ways: You can format the cell content type or format the
cell's visual look.

For example, a number, a number with a decimal, a percentage, or a currency
amount may display a cell contents format. There are several ways in which
dates can be seen.

Only right-click to format the content of a cell, select Format Cells Now press
OK to confirm cell format changes.

In the pop-up screen, you can see how a cell can be formatted as different
types or categories.

Display a cell as a number Click the number of the cell to display it as a
number in the pop-up.
You can pick the number of decimals to view here and toggle if you would
like to use a 1000 separator. You may also opt to include negative numbers in
red, or parentheses with a minus sign.

Remember that under the Sample line, you will see a sample of your
numbers.

Now pick Currency from the section Category for formatting numbers as
Currency. You can once again select the number of decimals, but you can
choose the currency symbol that you want to use this time too.

Consider your number currency and pick the Currency of your preference
Formatting numbers as a percentage One way to format the cell is also by
percentage. Tap on Class percentage and select the decimal number.

Please note, our number was originally 0.40 and will be 100-fold to 40
percent.

Don't worry, and it will always be considered at 0.4 if this amount is used for
calculations.



We also learned how to format cells as numbers, Currency, and percentages,
the most commonly used.

When you use more Excel, you can begin to search for quick ways to execute
those activities. 

A simple way to format cells: Since cell formatting is an operation, Excel has
a more straightforward way to do it in the top belt.

Select the Home ribbon and select the dropdown to quickly format cells in
different ways under the number tab.

In addition, you can find some additional icons in the dropdown menu to
easily format actions.

• The $ sign will allow you to pick a currency
• The percent sign will make the percentage in your cell 
• The other two signs will enable the number of decimals in your cell to
increase or to decrease.

Formatting text or numbers will make it noticeable, especially if you have a
large worksheet. Changing default formats involves changes to font color,
layout, scale, cell text, or formatting results. This shows how various formats
can be used and even recycled.

If you want the text or numbers in a mobile cell to appear in bold, italics,
single or double focus, you can select the cell and on the home tab and
choose the format you want: change font type, scale, color or add effects
Press Home and:

§ Click on the arrow next to regular size 11 and select a different text size to
raise or decrease the font size.
Tap Font Color and choose a color to change the font color.
Tap Fill Color next to Font Color to create a background color.
Click the Runner dialog and choose an Effects alternative to add a hit,

superscript, or subscript formatting.
You may position text in a cell so that it is centered, balanced on the left or
right. Change the text alignment.
You should add Wrap Text if it is a long line of text to make every text clear.



Use the text to match, and choose the alignment option you want on the
Home page.
Clear formatting.
To erase, choose the text, and click on the Home tab, press Clear > Clear
Formats to change mind after applying some formatting.
Cell Look Formalization: The Font section in the home menu on the top of
the Excel ribbon can be used to adjust the cell look.

To change the text color, click on the small icon A in the cell to choose the
color of the text.
Click on the Bucket symbol and choose your desired color if you want to
change the cell background color.
The Font section in the ribbon has many other exciting features to control the
look of your text. Adjusting the size, the dimensions, and the look of the cell: 
• Set the font size; 
• Raise and decrease the font sizes; 
• Make your text gross; 
• Underline your text Apply a cell border It's also straightforward to add a
border to your cells. Just click on the border icon in section Font and pick one
cell or a specific cell set.

A border options list will be released. Only choose and click where your
border will be seen.

To change your borders, look to a different color, click the Border icon again
and use the lower part. Change the border design and color.
• Choose color line for color change; 
• Choose line type for border change. Here you can strip your boundary in
different ways.
The layout of a cell and the cell data — or a group of cells — may be applied.
The cells are one way of thinking about this is through the frame of an image,
and the frame is the data. The cell formatting may include the introduction of
a line, the introduction of color or shades, and the adjustment of cell size or
design.



Apply Excel Styles

1. Select the cells.
2. Select Home > Styles and select a style.
Modify an Excel Style.
1. Select the cells with the Excel Style.
2. Right-click the applied style in Home > Styles. Select Modify.



ENTERING FORMULAS

An Excel Table is helpful in a structured display of data, but Excel is far
more useful. Thanks to its high computing ability, you can reach, control, and
evaluate numbers. You must learn about formulas that are mathematical
equations to take advantage of this feature. Here we explain how to construct
simple formulas in Excel that are much more complex.

Excel 2010, Excel 2013, Excel 2016, Excel 2019, and Excel Office 365 are
all subject to this process.

Excel Formula Basics

Writing a tablet is not like composing a mathematical equation. Instead of
starting with the same sign (=), Excel formulae begin with an equal sign (=).

The formula Excel looks like = 3 + 2 rather than 3 + 2 =.
The same sign indicates that it's not just a word or number, which you want
to appear in a cell, but part of a formula. The product of the formula appears
in your cell when you type the formula and enter on your keyboard.

For instance, the result 5 appears in a cell when you type the above formula,
= 3 + 2, and press Enter. The formula is still there, but it is not included in
your tablet. However, the formula is displayed on the top of the Excel screen
in the formulation bar when you pick the cell.

Upgrade Formulas with Cell References 

Excel formulas can also be created using cell references, with formula and
result shown. Continuing on our example, you would not enter the 3 and 2
numbers but instead name the cells where those numbers are entered (see For
more detail on cell naming, please use the following cell references). The
formula cell still shows the sum of the numbers in those cells when you write
a formula, even though the numbers change.

Below is an example of the real-life utility of this method. Tell you to lead a
sales team and chart your monthly and quarterly sales. Cumulative revenue
for the year will be determined. You use cell references to classify the cells
where these values can be found inside the table rather than entering each



quarterly selling value in a formula.

Using Cell Reference

Each cell in Excel is a part of one row and one column. Pages are labeled
with a number (1, 2, 3, etc.) on the left-hand side of the table and letter
columns (A, B, C, etc.) on the top. To refer to a row, using the letter and
number of a column together like A1 or W22 (always first the letter of the
column). At the head of the display in the Name Box close to a formula row,
you can see the reference for a cell.

The cell references in the formula bar specifically are noted in the following:
E2, I2, M2, and Q2. The sales figures for the salesperson named Jean are
quoted annually. The formula adds the numbers to the annual sales figure.
Excel recalculates if you change numbers in one or more of them, and the
result remains the sum of numbers in the referred cells.

Build a formula with cell references to use cell references, seek to construct a
simple formula.

First, you need to add data to the table. To become an active cell, open a new
Excel file, and pick cell C1.

MS Excel chart with cell C1 Type 3 selected in a row, then presses In.

You should select the MS Excel spreadsheet with one cell with Cell C2 info.
Use C2 cell if it isn't. In cell type 2 and press Enter. Type 2.

MS Excel table with two data cells; Now constructs the file. Select D1 and =
C1+C2 form. Please note that this cell is illuminated when you type each cell
reference.

MS Excel table with two cells typed in a third cell press entry with data and
formula for completing the formulation. Answer 5 is given in cell D1.

The full form = C1+C2 appears on top of the worksheet in the formula bar
when you pick cell D1 again.

Another way that relates to values that you choose to use in your



specification is by the use of your pointer to pick cells that are used in your
format.

MS Excel table with specific cells, accompanied by the Enter cell references.
It is also the most accurate method because you remove the chance of error
typing numbers or cells. This method is the fastest of the ones we have
mentioned. Click Cell E1 to enable it as the active cell and type it in an equal
sign (=). Here is how to do so, starting with the table of examples above.
MS Excel Table with Some Filled Cells
Pick cell C1 to join the cell relation in the formula using your pointer.
MS Excel table with the following formula Choose a plus sign (+) then pick
C2 for the second cell reference. Take the MS Excel table.
Click Enter to complete the formulation. MS Excel table with the following
formula 
MS Excel table with multiple cell filled Switch cell data from cell C1 to cell
C1 and click Enter on your keyboard to see if changing one of the formula
values changes the outcome. The tests of cells D1 and E1 will differ from 5
to 8, but the formulas will remain the same.

MS Excel Table with Several Cells that Include Mathematical Operators
and Order of Operation
Now we are moving to other operations, including
subtraction or minus sign(-)

addition – plus sign(+)
division – forward-slash(/)
multiplications – asterisk (*)

exponentiation – caret(^)
If more than one operator is being used in a formula, Excel follows a

particular order for performing mathematical operations. The mathematical
operators that are used in Excel are the same as those that you recall from
mathematical classes. The BEDMAS acronym is a simple way of recalling
the order of operations.

The Multiplication Addition Subtraction Excel division of Brackets
Exponents treats division and multiplication as equal. It does these operations
from left to right in the order in which they occur. The same applies to add
and subtract.



Below is a clear example of how operations are being carried out. The first
Excel operation is completed in a formula = 2*(3 + 2) with the result five
inside the brackets (3 + 2). The multiplication operation, 2 * 5, is performed
with the outcome of 10. (The values in the formula may be represented by
cell references rather than numbers, but Excel would perform these
operations in the same order.)

Let's construct a more complicated formula now in a Hybrid Formula.

Open a new tab and add the following: 
7 in C1
5 in C2
9 in cell C3 
6 in C4
3 in the C5 

MS Excel Table of Cells 
Click cell D1 to enable it as the active cell and select the same sign following
the left bracket (=().

MS Excel Table with the Evolving Formula 
Click cell C2 to join the formula cell reference then select the minus sign-).
(MS Excel table).

MS Excel Table with Formula 
Select cell C4 to enter the cell relation in the formula and insert a right
bracket)). (MS Excel disk.
Form multiplication sign (*), choose cell C1 to enter this cell relation in the
formula, then select MS Excel tablet with progress formula.

Type the plus sign (+), and then select C3 to insert this cell reference into the
formula. Click the plus sign (+).

MS Excel with the Advancing Formula
Click the sign(/) of the divisions, pick C5 for this cell reference.

Press Enter to complete the form. MS Excel table with formula in progress.
Answer -4 is shown in cell D1.



In the example above, Excel achieved the result of -4, using the BEDMAS
rules as follows. MS Excel spreadsheet with a few cells How Excel measures
the outcome. With a -1 performance, Excel first carried out a C2-C4 or 5-6
procedure within the brackets.
Exhibitors
This formula has no exponents, so Excel has skipped this step.

Division and Dissemination
Both of these operations are performed by Excel from left to right. Second,
the -1 by 7 (cell content C1) is multiplied to produce a result of -7. The
procedure, C3/C5 or 9/3, was carried out for a result of 3.
Subtraction and extension. For the outcome of -4, Excel conducted the final
process -7 + 3.

OPEN the Excel workbook with the "known" values to be plotted on a
calibration curve. 



CALIBRATING COLUMNS

Set up the data in pairs with the values in adjacent columns that are entered
pair by pair. There will be correct headings for the data columns. If data
requires a particular order, sort by one of the columns.

Underline all the data used by the calculation curve. Click/Tap the heading at
the top of the data column to the right (in the example, labeled "x"). Click the
button on the mouse and move the mouse pointer to the left-hand column of
the last cell (in the example called 'y'). Remove the button of the cursor. To
show the gallery of scatter map variations, click on the Insert tab and click on
the Disperse map button. To generate a dispersion chart with a marker
representing each data pair, click on the Marker only option.

For this example, a series of 10 data pairs, each consisting of an X-value and
a Y-value, are used for the creation of a calibration curve. The X-values
would be our 'standards,' and they may be anything from the concentration of
the chemical solution we test through a scientific instrument to the software
input variable controlling a launching machine in marble.

The Y-values are the "responses," and they represent the measured distance
from the marble that landed by each input value or the instrument given to
calculate each chemical solution.

When we have a graphical view of the calibration curve, we are using the
SLOPE and INTERCEPT functions to measure the formulation of the
calibration line and decide if a concentration of the "unknown" chemical
solution would rely on the instrument's lecture.

Step 1: Build your chart Our basic example table contains two columns: X-
Wert and Y-Wert.

Create an x-value and y-value column Start by choosing the chart data.

Select the column cells for 'X-Value' first.



Then press the Ctrl key and click/tap on the cells of column Y-Value.

Hold Ctrl on the "Go" tab when you press the value column.

Insert tab Navigate to the menu "Charts" and pick "Scatter" from the first
option on the file.

Select > Diffusion Map containing the two-column data points will appear. A
map will appear.

A chart appears; Click on one of the blue dots to pick the sequence. When
selected, the points are illustrated in Excel.

Right-click one of the points and pick the option "Add Trendline."

Select the trendline option. Add a straight line to the map.

Now the trendline is shown on the map

The "Format Trendline" menu is shown to the right of the screen. The R-
squared is a statistic that says how closely the line fits the results.
Checkboxes at "Display Equation in Chart" and "Show R-squared values in
the table." It ensures that every data point crosses the line. The best R-
squared value is 1.000. The r-square value decreases with 0.000 being the
smallest possible values as the gaps between data points and the line increase.

The trendline format pane The trendline equation and R-squared figures
appear on the map. Notice that the correlation of the data with an R-squared
value of 0.988 is perfect in our example.

The equation takes the form of "Y = Mx + B" and M is the slope, and B is the
y-axis of the graph.

Equations are now on the map. Let us focus on modifying the map by editing
the text, inserting the names of the axis, and now that the calibration is
complete.

Click on it to pick the text to adjust the Chart heading.



Change the title of the chart Form a new chart title now.

To add x-axis and y-axis names, first navigate to Chart Tools > Design, you
have to use the new names tab.

Click on the "Add a Chart Item" button on the file. Go to chart tools.

Now, navigate to Axis Titles > Primary horizontal. Click to attach the chart
feature button.

Tools for Head to Axis > Horizontal Primary Axis Description will be shown.

To rename the axis heading, first, pick a text, then enter a new title. Axis
heading will appear.

Now, go to Titles > Primary Vertical. Change the title of the axis now.

Adding the heading of the primary vertical axis An axis heading is seen.

Displaying the new titular axis Rename the title with the text chosen and the
current title typeface.

Renaming the title axis then your map is done now.

Display the complete map

Step Two: Now let us measure the line equation and R-squared statistics
using Excel's built-in SLOPE, INTERCEPT, and CORREL functions.
Measure the line equation and R-square statistics.

We attached names for these three roles to our sheet (in row 14). In the cells
under these titles, we must perform the actual calculations.

Next, we are going to compute the SLOPE. Choose A15 cell.

Use a pitch data cell Navigate to Model > More Functions > Statistical >
SLOPE.

Forms > More functionality > Statistical > SLOPE Window Arguments
function shows up. Select or type the Y column cells in the "Known ys" area.



Choose or select the cell column Y-Value. In the field "Known xs," choose or
select the cells of the X-Value column. In the SLOPE function, the order of
the areas "Known ys" & "Known xs" matters.

The last formula in a formula bar is the following: = SLOPE (C3: C12, B3:
B12). Note that in a cell A15, the value returned by the SLOPE equation
matches the value shown on the table. The final formula in this formula bar
should be the same:

Next, select cellid> Formulas > More Functions > Statistical > INTERCEPT
and then move through Formulas.

Fold in > More functionality > Statistics > INTERCEPT The Arguments
function window should appear on your website. For the "Known ys" area,
select or type in the Y column cells.

Choose or type in the column Y-valued Cells. For the "Known xs" region,
choose or select the column X-Value Cells. Included in the INTERCEPT
function is the order of the 'Known ys' and 'Known xs' fields.

The final formula will appear as follows in the formula bar: =
INTERCEPT(C3: C12, B3: B12) Observe that the number returned by the
INTERCEPT function is the value of the y-intercept shown in the table.

Select C15 and move to Formulas > More Functions > Statistical >
CORREL. Next view of intercept function

Navigate to the Task Arguments window > More functions > Data >
CORREL For the "Array1" sector, pick or type one of the two cell ranges.

The order does not influence the performance of the CORREL function,
unlike SLOPE and INTERCEPT.

Type the first cell area. Select or select for the area "Array2" in the other two
cell ranges.

The formula is expected to appear in the formula bar as follows:
=CORREL(B3:b12, C3: C12) Note that the value returned from a CORREL
feature does not suit the 'r-squared' value in the table. Enter the second cell



field Click 'OK.' The CORREL function returns "R" in order to calculate "R-
squared" by adding a "^2" within the function bar to square the value that is
replaced with the CORREL function at the end of the formulation. Returns
"R" The completed form now will look the same: = B3: B12, C3: C12)^2
Press Enter. Press Enter.

Display the completed form The "R-squared" value now matches the value
displayed in the chart after adjusting the formula.

Now you can make use of these available values in simple formulas to
deduce the concentration of that "unknown" solution or the input we can
enter in that code so that the marble flies a certain distance. That is, the r-
squared value now fits step Three: Set Up Forms For Fast calculation Values.

This step defines the requisite formulas for you to enter an X-value or a Y-
value and to calibrate the corresponding value.

Specifications are in the form of the "Y-value = SLOPE * X-value +
INTERCEPT," and then a solution is created by "Y-value" by multiplying the
X value and the SLOPE and then adding INTERCEPT to the "Y-value"
equation. The "Y-value"

For example, we have set zero for the X-value as an example. The returned Y
value should be equal to the INTERCEPT of the most suitable line. It works,
and we know that the formula works well.

The zero as the X value equals the INTERCEPT X-value solving based on
the value of Y shall be expressed by the subtraction of the value of Y from
the INTERCEPT, and the result shall be divided by SLOPE: X-value=(Y
value-INTERCEPT)/SLOPE for an x value based on a value of Y as an
example, we used INTERCEPT as a value of Y. The returned x-value should
be zero, but the returned value should be 3.14934E-06. The returned value is
not null since we truncated the result INTERCEPT unintentionally when the
value was written. However, the formula works correctly since the product of
a calculation is 0.00000314934.



Displaying Truncated Results

You can enter the first thick bordered cell with any X-value you want, and
Excel will automatically calculate the corresponding Y-value.

The corresponding X value is given by solving Y for an x value Any Y value
entering in the second thick-bound cell. It is the formula for measuring the
solution's concentration or what input is required to send the marble over a
certain distance.

To add a trend line to the spreadsheet, right-click on the "y" data curve, and
choose Add Trendline from the pop-up menu. Select the Linear and press the
Close button from the Format Trendline dialog window.

Use the choices shown in the Design tab of the Table Tools chart to alter the
look or to select different formats of the chart.



COPYING FORMULAS WITH AUTOFILL

By using the fill handle, you can quickly copy formulas into adjacent cells.
Excel can give different results for each cell if you move the handle to other
cells. Dragging the fill handle, copy a formulation Follow the following
steps:

1. Select the cell with the formula to be filled into neighboring cells.

2. Drop the cursor in the bottom right corner to become a plus sign (+), like
this,

3. Drag and drop your fill handle over the cells you want to fill. The figure in
this instance shows the fill handle being pulled down,

4. Once you leave the formula, the other cells are immediately loaded,

5. Click the AutoFill Options button after you have finished dragging, to alter
how you want to fill cells, and choose the option you would like.

Tips: § To complete the formula in a column, you can also press Ctrl+D.
Select first the cell with the form, then pick the cells below the form, and then
press Strg+D.

§ To fill the formula right in a row, you can also press Ctrl+R. First, select
the cell with the shape, select the cells on the right side, and then click on
Ctrl+R.

Data analyzes are often required and necessary on a broad dataset. The data is
summarised, the correct values are collected and the results reported.

Excel offers PivotTable to allow you to easily and quickly summarize
thousands of data values to obtain the results required.

Take into account the following revenue data table. You will have to



summarize from this data the total area of revenue wisely for a month. The
easiest way to manage these tasks is to create a PivotTable that can be
changed dynamically to summarize the outcome as you want.

Build PivotTable

Make sure that the first row has headers to construct PivotTables.

Click the list. Press the screen.

Click Ribbon's INSERT tab.

In the table section, click PivotTable. The dialog box of PivotTable is seen.

You may either use a chart, Set or an external data source, as shown in the
dialog box.

Type the name of the table in the Table / Range File.

To say Excel where to store PivotTable, click on New Worksheet.

A Blank PivotTable is available and a list of fields of PivotTable is shown.

Recommended PivotTables

You can use the Recommended PivotTables that Excel offers if you are new
to PivotTables or you are not aware of which fields you want to choose from.

Click the data table. Open data table.

Press INSERT. Press INSERT.

In the Tables section, click on Suggested Tables. A dialog box appears for the
Recommended PivotTables.

The potential custom PivotTables matching your data is shown in the
suggested PivotTables dialog box.

To view the preview on the right-hand side, click on each of the PivotTable



choices.

Click on Salesperson's and month's PivotTable Order Number.

Click OK. A new worksheet displays the selected PivotTable. The fields
listed in the PivotTable fields list can be accessed.

The headers will appear in the data table as fields in the PivotTable.

PivotTable Fields

You can opt to change your PivotTable immediately to reveal only the details
you want and how you want to. For example, if you want the account details
to be shown instead of order quantity, uncheck Order Quantity, and select
Account.

You can also adjust the configuration of your PivotTable instantly.

PivotTable Areas

For this, you should use the PivotTable Locations.

In PivotTable regions, you can pick − Which fields are to be displayed as a
row? Which columns will you see? How to compile the data filters for any
one field while updating your PivotTable layout can immediately update it
when you push the fields around regions, or you can delay it and update the
update only if you press UPDATE.

You can simply drag and watch the table layout as you do these areas.

Nesting in the PivotTable

When you have more than one region in one region, then the order you
position the fields in the area is the nesting technique. By dragging the fields,
you can change the order to see how nesting changes. You will see that
months are in columns in the above layout choices.

In that order, area, and salesman in line. That is to say, salesperson values
under national values are nestled.



The summary is the sum of the volume of payment.

There are no chosen filters.

The resulting pivot table is: In the pivot table regions, select region and move
it under the salesperson as follows − Nesting sequence adjustments and
PivotTable as follows − Remember − The configuration in the nesting
sequence – Region and subsequently the salesperson generates a stronger,
more compact report than the nesting order-Salesperson − Salesperson: When
you have to sum up your sales by a dealer, the second layout would have
been a better choice if the seller represents more than one region.

Filters

You can assign one of the fields a filter to adjust the pivot table dynamically
on the basis of this field's values.

Clicking the ANALYZE Ribbon Extends or Collapses Area.

If you have a symbol Expand Collapse, you pick the cell containing East
from the PivotTable on the left of the selected sector.

To the left of the East, click on the Collapse button.

All things would have collapsed under the east. The Collapse symbolizes the
extend symbol on the left of the North.

You can see that only the things underneath the east collapse. The majority of
the elements from the PivotTable are the same.

To the left of the North, press the Expand button. All items below are shown
below.

Using the Ribbon commands Extend field and collapse area, you can
compress or rotate all objects on the PivotTable at once.

In the PivotTable, press the Eastern node.

Click on the Ribbon Examine tab.



In the Active Field category, select Collapse Field.

The PivotTable will collapse all things from the East Area.

For the Effective Field section, click on the Expand Area.

All the things are seen.

You can choose the presentation style of your PivotTable as you wish as a
text. Reports Presentation Styles Use a similar look in the rest of your study
or presentation. Nonetheless, don't get sick with types, because a report that
affects the results is always better than a fun report that doesn't reveal
important data points.

PivotTable Press East.

Click ANALYZE.

Click the Active Field group for Field Settings. A dialog box for field settings
is shown.

Tap on the Print and Design tab.

After every element sticker, insert the blank line.

After each value of the region area, blank rows will be displayed.

In the Template tab, you can also insert blank lines.

Click the Project tab. Select the Project button.

In the Design section, press report style.

In the drop-down column, select Show in Outline Form.

Flip over PivotTable Styles with the keyboard. A glimpse of the mouse
model will be shown.

Use the right style for your study.



The outline type PivotTable will appear with the selected Design.



CHAPTER FIVE

TIPS AND TRICKS

SHORTCUTS FOR WINDOWS AND MAC

PC (Windows) Shortcuts & Mac Shortcuts

Editing shortcuts

Edit active cell F2 CtrlU

Cut CtrlX ⌘ X

Copy CtrlC ⌘ C

Paste Ctrl ⌘ V

Paste Special Alt ES ⌘  Option V

Paste name into formula F3 

Toggle references F4 ⌘ T

Start a new line within the same cell AltEnter Ctrl Option Return

Insert or edit cell comment Shift F2 Shift F2

Display shortcut menu (i.e. same as right-click) Shift F10 Shift F10

Insert worksheet Shift F11 Shift F11

Define a name for a cell Ctrl F3 Ctrl F3

Fill down (e.g. copy the formula down in selected cells) CtrlD Ctrl D

Fill right Ctrl R Ctrl R

Insert argument names and parentheses for a function after typing a function
name in a formula Ctrl Shift A Ctrl Shift A
Insert row Alt I R Ctrl I



Insert column Alt I C Ctrl I

Formatting Shortcuts

Brings up format cells menu Ctrl 1 ⌘  1

Bold Ctrl B ⌘ B

Italic Ctrl I ⌘  I

Undo CtrlZ ⌘ Z

Redo Ctrl Y ⌘ Y

Repeat last action F4 ⌘ Y

Select all used cells (select entire worksheet if the command is repeated) Ctrl
A ⌘ A

Number format Ctrl Shift !CtrlShift!
Date format Ctrl Shift # Ctrl Shift#

Percent format Ctrl Shift % Ctrl Shift%

Increase font size Alt h fg ⌘ Shift>

Decrease font size Alt h fk ⌘ Shift<

Increase decimal Alt h O

Decrease decimal Alt h 9

Increase indent Alt h 6 Ctrl M

Decrease indent Alt h 5 ⌘ Shift m

Navigation Shortcuts

Move from cell to cell Arrows Arrows

Go to F5 F5



Go to cell A1 Ctr l Home Fn Ctrl Lеft

Go to beginning оf row Hоmе Fn Lеft

Sеlесt thе аdjасеnt сеll Shіft Arrow Shift Arrow

Sеlесt еntіrе row Shift Sрасеbаr Shift Sрасеbаr

Select entire column Ctrl Sрасеbаr Ctrl Sрасеbаr

Select all to the ѕtаrt of the ѕhееt Ctrl-Shift Home Ctrl Shіft Hоmе

Sеlесt all to thе lаѕt uѕеd сеll оf thе sheet Ctrl-Shift End Ctrl Shіft End

Sеlесt to the end of the lаѕt used cell in row/column Ctrl Shіft Arrоw Ctrl
Shift Arrow

Sеlесt thе lаѕt uѕеd сеll in row/column Ctrl Arrow CtrlArrow

Move one screen up PageUpFnUp

Move one screen down Page Down Fn Down
Move one screen left Alt PageUpFnOptionUp

Move one screen right Alt PageDownFnOptionDown

Mоvе to thе nеxt оr рrеvіоuѕ wоrkѕhееt (Move between tаbѕ іf уоu аrе іn a
menu window) CtrlPаgеUр/Dоwn Ctrl PаgеUр/Dоwn

Move tо nеxt workbook (whіlе іn ѕрrеаdѕhееt) Mоvе to nеxt divider (whеn іn
mеnu options) Ctrl Tаb Ctrl Tаb

Move tо the next cell (Move bеtwееn items wіthіn a menu wіndоw) Tаb Tаb

Fіlе Shоrtсutѕ

Nеw Ctrl N ⌘  N



Oреn Ctrl O ⌘  O

Sаvе workbook Ctrl S ⌘

Sаvе Aѕ F12 ⌘⇧ Shift S

Print Ctrl P ⌘  P

Oреn рrіnt рrеvіеw window Ctrl F2

Gо to nеxt wоrkbооk Ctrl Tаb ⌘  -

Close fіlе Ctrl F4 ⌘  W

Clоѕе all open Excel fіlеѕ Alt F4 ⌘ Q

Rіbbоn Shortcuts

Shоw rіbbоn ассеlеrаtоr kеуѕ Alt

Shоw/hіdе rіbbоn CtrlF1 ⌘⌥ R

Paste Special Shortcuts

Paste Special formats CtrlAltVt  Ctrl ⌘ Vt

Paste Special values CtrlAltVv  Ctrl ⌘ Vv
Paste Special formulas CtrlAltVf  Ctrl ⌘ Vf

Paste Special comments CtrlAltV c  Ctrl ⌘ Vc

Clear Shortcuts

Clear cell data Delete  Delete

Clear cell formats  Althef



Clear cell comments  Althem

Clear all (data, formats, comments) Althea

Sеlесtіоn Shоrtсutѕ

Select a cell rаngе Shіft Arrows Shіft Arrows

Highlight a соntіguоuѕ range Ctrl-Shift Arrоwѕ Ctrl-Shift Arrows

Extend ѕеlесtіоn uр one screen Shіft PаgеUр Fn Shift Up

Extend selection down one ѕсrееn Shift PageDown Fn Shift Down

Extend ѕеlесtіоn left one ѕсrееn Alt ѕhіft PаgеUр Fn Shift ⌘ Up

Extend selection right one ѕсrееn Alt ѕhіft PаgеDоwn Fn Shift ⌘  Down

Sеlесt аll Ctrl-A  ⌘  A

Dаtа Edіtіng Shortcuts

Fill dоwn frоm сеll аbоvе Ctrl D Ctrl D

Fіll right frоm cell lеft Ctrl R  Ctrl R

Fіnd аnd rерlасе Ctrl F Ctrl F

Show аll соnѕtаntѕ F5 Alt s o

Hіghlіght cells wіth соmmеntѕ F5 Alt s c

Data Edіtіng (inside cell) Shоrtсutѕ

Edіt thе асtіvе cell (edit mode) F2 F2

While еdіtіng сеll, allow uѕе оf arrow keys tо сrеаtе reference F2 F2

Cоnfіrm сhаngе аnd get оut оf cell 



Click Entеr

Cаnсеl a сеll entry and gеt оut оf cell Eѕс Eѕс

Insert lіnе brеаk within сеll Alt Entеr Oрtіоn Entеr

Hіghlіght wіthіn a сеll Shіft Lеft/Rіght Shіft Lеft/Rіght

Hіghlіght contiguous іtеmѕ Ctrl Shift Lеft/Rіght Ctrl Shіft Lеft/Rіght

Jumр to bеgіnnіng оf cell contents Home Fn Left

Jumр tо еnd of сеll contents End Fn Right

Dеlеtе сhаrасtеr tо lеft Backspace Dеlеtе

Delete character tо rіght ` Dеlеtе Fn delete

Ассерt autocomplete ѕuggеѕtіоn Tab Tab

Rеfеrеnсіng a cell from аnоthеr worksheet CtrlPageUp/Down Arrоwѕ Ctrl Fn
Dоwn/Uр Arrоwѕ

Other Shоrtсutѕ

Enter dаtе Ctrl; Ctrl ; 

Enter tіmе Ctrl Shіft: Ctrl Shіft :

Shоw fоrmulа/ѕhоw values (kеу tо the lеft оf 1) Ctrl, Ctrl.

Select сеllѕ that rеfеr tо thе active cell (uѕеful bеfоrе deleting a cell in a
wоrkѕhееt) Ctrl ] Ctrl]

Drіvеѕ mеnu bar Alt

Nеxt open program Alt= ⌘ Tаb

Autоѕum Alt = ⌘ T



Ext ореn ѕоftwаrе Alt= Tab

Autоѕum Alt= T

Rеаѕоnѕ to Uѕе Excel Shоrtсutѕ

To be mоrе еffесtіvе, ԛuісkеr, and more reliable when creating financial
mоdеlѕ оr соnduсtіng financial analysis, it is important to know the keyboard
ѕhоrtсutѕ in Excel.



SIMPLE WAYS TO MANAGE
YOUR DATA

Perhaps, if you find yourself in a situation where you need to update your
data manually, you probably lack a formula that can do it for you.

Data is the foundation of every analysis you render in Excel. And when it
comes to information, there are loads of things that can go wrong – be it
structure, positioning, formatting, extra space, and so on.

Extra spaces are incredibly hard to find. Although you can somehow see the
additional spaces between words or numbers, the trailing spaces are not
visible. The Excel TRIM feature uses the cell reference (or text) as input.
Removes forward and trailing spaces, as well as additional spaces between
terms (except single spaces).

Blank cells will cause havoc if they are not treated beforehand. Sometimes
one might encounter issues with empty cells in a data set that is used to
construct reports/dashboards.

You may want to fill in all blank cells with '0' or 'Not Available,' or you may
only want to highlight it. If there is an extensive data collection, it could take
hours to do this manually. Luckily, there's a way you can pick all the blank
cells at once.

Select the complete data set Press F5 (this opens the Go to dialog box) Click
the Special button (bottom left). This opens the Go to Special dialog box
Select Blank and clicks OK This will pick every one of the blank cells in the
users' data set. If you want to enter 0 or Not Accessible in all of these cells,
just type it and press Control + Enter (remember if you just press Enter, the
value will only be inserted in the active cell).

Often when you import data from text files or external databases, the
numbers are stored as text. Also, some people are in the habit of using an
apostrophe (') in front of a number to render a statement. It could cause
severe problems if you use these cells in your calculations. Here's a dumb
proof way to convert those numbers stored as text back to numbers.



In any blank cell, type 1 Select the cell where you typed one and click
Control + C Select the cell/range that you want to convert to Select Paste – >
Paste Special (KeyBoard Shortcut – Alt + E + S) In the Paste Special dialog
box, select Multiply (in Operations Category) Click OK. It converts all
numbers in text format back to numbers.

There can be two things you can do with duplicate data – highlight it or erase
it.
Highlight Duplicate Information: · Select Information and go to Home – >
Conditional Formatting – > Highlight Cell Rules – > Duplicate Values.

· Define the formatting, and all duplicate values will be highlighted.
Replace Duplicates in Data: · Select Data and go to data- > Delete
Duplicates.
· If your data has headers, please ensure that the checkbox at the top right is
verified.
· Choose the Column(s) from which you want to delete duplicates and click
OK.
This will delete redundant values from the register. If you want the original
list to be intact, copy-paste the data to another place and do this.

There are two different ways in which Errors can be a highlight in Excel Info:
Use Conditional Formatting Select All Info Set Go to Home –> Conditional
Formatting –> New Rule In New Formatting Rule dialog box, select 'Format
Only Cells Containing' Select Errors from the Formatting Format drop-down
and click OK. This highlights any error value in the chosen dataset Using Go
To Special Select the complete data set Press F5 (this opens the Go To dialog
box) Click the Special button at the bottom left of Select Formulas and
uncheck all options except Errors This selects all the cells that have an error
in it. Now you can manually highlight, erase, or type something in it.

Switch Text to Lower / Upper / Proper Case

If you inherit a workbook or import data from text files, names or titles are
often not clear. 

Usually, all of the text could be in the lower / uppercase, or it could be a
combination of both. You can quickly render all of this transparent by using



the following three functions: LOWER) (– Converts all text to Lowercase.

UPPER) (– Converts all text to Uppercase.
PROPER) (– Converts all text to the correct event.

Parse Data Using Text to Column

When you get data from a database or import it from a text file, all text may
be enclosed in a single cell. You can parse this text into several cells by using
the Excel Column Text feature.

Pick Data / Text that you want to interpret Go To Data – > Column Text (this
opens Text to Columns Wizard) 

Step 1: Choose Data Form (pick Delimited if the data is not evenly spaced
and is divided by characters such as comma, a hyphen, dot.) Click Next.
Step 2: Select Delimiter (a character that separates your data. You can choose
a predefined delimiter or something else using the Other option. 
Step 3: Choose a data format. Select the destination cell as well. When the
destination cell is not chosen, the current cell is overwritten. Nothing reduces
the work's reputation than a spelling mistake.

Using the F7 Keyboard Shortcut to Run a Spelling Test for Your Data
collection

Each database had its data formatting. Once you have all the data in place,
here is how you can uninstall all the format at one go: 

Select the Go to Home – > Clear – > Clear Formats Dataset. Likewise, you
can also remove only the comments, hyperlinks, or text.

Finding and replacing is essential when it comes to data cleaning. For
example, you can pick and delete all zeros, change the formula references,
find and change the formatting, and so on.



Microsoft Excel has many similarities, which may make it difficult to
determine which software you can use. 

For example, both programs can store large quantities of data, run powerful
queries and analytics tools to slice and dice the data and perform complex
calculations to return the data you need.

Nonetheless, each system has specific advantages, depending on the type of
data you handle and what you want to do with the data. For example, if you
aim to preserve data integrity in a format that can be viewed by multiple
users, Access is your best option. At the same time, Excel is better suited for
complex numerical data that you want to analyze in-depth.

In certain instances, both programs may be used, each for the function for
which it is best suited. In general, Access is best suited to handling data:
helping you keep it organized, making it easy to browse, and making it
accessible to multiple simultaneous users. Excel is typically best suited for
analyzing data: conducting complex calculations, investigating possible
results, and generating high-quality charts. If you use Access to store your
data and Excel to explain it, you will benefit from both programs.

Once you decide which program to use, you may want to compare the
advantages of each program, learn when it's best to use one or the other, and
figure out how to work with both programs to get precisely the results you
want.

Note: All suites of Microsoft Office include Excel, but not all suites include
Access.

Compare the Advantages of the System 

Choosing the right policy is essential if you want to access and update the
information with optimal consistency and accuracy. To find out which
software is better suited to the tasks you want to perform, it can help to
compare the benefits that each software has to offer in terms of data storage,
data analysis, multi-user collaboration, and security.

Data Storage
Data analysis



Multi-user collaboration
Security

When Using Access

In every general term, Access is the best option when you need to track and
record data periodically, and then view, export, or print subsets of that data.
Access types offer a more comfortable way to work with your information
than Excel worksheets. You can make use of Access to automate frequently
performed acts, and Access reports let you summarize the data in print or
electronic form. Access allows more structure for the data; for example, you
can monitor which types of data can be entered, which values can be entered,
and you can determine how data in one table is connected to data in other
tables. This framework allows you to ensure that only the right data forms are
entered.

Access stores data in tables that look about the same as worksheets — but
Access tables are built for complicated queries of data stored in other tables.

Using Access when you:

Anticipate the need to add tables to the data collection that started as a flat or
non-relational table.

Connection Need to run complex queries.

We need to produce a range of reports or mailing labels.

By using Excel as a spreadsheet system, Excel will store large quantities of
data in workbooks containing one or more worksheets. Nevertheless, instead
of being used as a database management system, such as Access, Excel is
designed for data processing and calculation. You can use this versatile
software to create models for data analysis, write simple and complex
formulas to measure the data, rotate the data in whatever way you like, and
display the data in a variety of professional-looking charts.

Using Excel when you: apply to Allow a flat or non-relational view of your
data instead of a relational database that uses several tables and when your
information is mainly numeric.



Frequently run calculations and statistical comparisons on your results.

Wanting to use PivotTable reports to display hierarchical data in a compact
and versatile layout.

Connection Plan to create charts regularly and to use the new chart formats
that are available in Excel.

Using conditional formatting icons, data lines, and color scales to highlight
your results.

Want to conduct sophisticated what-if analysis operations on your results,
such as statistical, regression, and engineering analysis.

If you want to keep track of items in a single list, either for personal use or
for specific collaboration purposes. Excel is, without a doubt, the software
that most people and businesses would use to handle data. This being said;
hopefully, it can be used not only to fill up spreadsheets with numbers and
names but also as a tool for quick access to the data you're trying to handle.

To be able to do so efficiently, there are many resources that the program
offers to allow almost everyone to keep their data up-to-date at all times.
Below are some of the ways you can easily handle your data in Excel.

Plan the tables & categories before you start entering the data Build a system
that you can extend to all the workbooks that you have that will be a perfect
way to keep track of how the data is organized.

Let's assume, for example, that the data you have reflects monthly or even
daily sales figures. When you already have a system that allows you to enter
the overall amount, the date and the idea of what those sales reflect, it's going
to be convenient for you to look at every single time.

Not only that but also with the use of different formulas and variations, you
will be able to construct different groups from the same data. For example,
using the Microsoft Excel query feature, you would be able to automatically
generate various charts that display unique revenue figures per month or by
definition. Mainly, we're talking about the same data being used in several
ways.



Validate the data that you have if you collect data through a survey or ask
questions from a landing page, you could end up saving a whole bunch of
data that you don't need or don't need. Being able to filter out incorrect
information is another type of data management. To be able to spot fake
email addresses in Excel, for example, could save you a lot of time trying to
participate in email marketing campaigns or even contact potential clients.
It is going to be a straightforward thing. What you need to do is have a list of
emails that you need to review in the spreadsheet and apply the valid email
address feature to the column. Quickly, the software can show pop-ups that
indicate when the content written in a cell does not have the right email
format.

A similar feature can be used to ensure that only appropriate phone number
formats are used for different cells. It will help you to see which knowledge
you have may be of use to you. Removing data that is not useful is also a
simple way to handle the data that you have.

Drop-down lists to assist with data processing; The favorite features of
intermediate and advanced users of Excel are drop-down lists. Commonly
referred to as a 1-minute drop-down list. That's because if you have the data
you need, you can build those lists in less than a minute. It's an easy but
beneficial way to handle data.

Like with almost every task in Excel, you are going to need the data you need
to build a chart on the spreadsheet. From there, you only need to click on the
data validation in an empty cell, and then go to the list. Right here, you are
going to be able to select which data is going to be on the list.

You may add this feature to your pre-built charts or other parts of the
spreadsheet. This will make data entry a much simpler operation, as the
choices will already be set out in front of you. Within a few taps, you're going
to be able to fill out all sorts of forms.

Information processing does not have to be a long and messy operation.
Those are a few of many things that can be included with an excel document
with the order to be able to handle any data accurately. As you can see, these
are necessary steps. Some of them do not even need you to memorize a



formula. Alternatively, they are directly accessible from the toolbars.

The easiest way to find the right interface to handle the data is to take some
time and get familiar with the idea of the several tools you can work with.
You can mix and match this way to create a spreadsheet that works for your
unique needs.



SIMPLE WAYS TO ANALYZE YOUR DATA

Excel can create tables to generate simple reports.

When monitoring your business results, it is useful to build subtotals of
revenue, of stock, by section, by the date the list is
almost infinite. Mainly, you want a reporting dashboard where you can pick
every aspect of your business and monitor its current results.

You may be aware that you can auto-filter tables in Microsoft Excel. This
means that your table with 20 columns and 1000 rows can be sorted and
filtered by any column, such as the date. in this method, you can
simply see all your orders for March, for example. So far, it's supposed to
sound familiar. Wouldn't it be awesome if your dashboard was also changed
by the act of filtering your table?

The good news is that they do, and you don't need to be an Excel specialist to
do so. Assuming that you have a number of sums in Column B. You could
have measured the sum using the "= SUM(B: B)" formula.
If you filter by year, the total number does not change. It is because there are
still other directives, you probably can't see them at its moment.

What you want is an alternative to the SUM rule, which only counts visible
rows. Fortunately, one exists, and that's the SUBTOTAL function. The
SUBTOTAL function can sum up the data, and it can average the data, it can
count the data, it can do almost everything about the data. The distinction
between the SUBTOTAL function and every other Excel function is
that it only uses the data displayed in its calculations.

The SUBTOTAL function will include subtotals for the data displayed in
filtered tables. It will help you create fast, versatile, numeric dashboards for
reporting. Unfortunately, it's not a positive thing if you want to map your data
on maps. If you create a bar chart to track monthly results,
it's not a good thing if you're in the same cell for January and February. This
is also helpful if you can use subtotal data at the same time each month.

This can be achieved using the functions of SUMIF and COUNTIF. The
SUMIF function allows you to SUM all data associated with a certain



amount, e.g., all sales in March. The COUNTIF function lets you know how
many data items are associated with a certain value, e.g., how many orders
were issued in April.

You may find these two functions are a little restricting because the
COUNTIF function does not allow you to count how many orders over $500
were received in April, i.e., you can only rely on one criterion. It is different
from our filtered table, where it is entirely possible to reveal only orders of
more than $500 earned in April.

The remedy is to split the research into various phases.
You can add an extra column to your table and use the Excel IF feature to fill
it with 1s and 0s depending on whether the order value exceeds $500. You
can then use the SUMIF / COUNTIF functions in the new data column. You
should cover the column to keep things tidy.

There are a few numbers of methods that can be used to analyze the data. A
variety of statistical packages are available and this, of course, includes
Microsoft Excel, which is free and can often be used for easy, efficient
analysis.

Using the following table as an example, several methods of data analysis in
Excel will be discussed, including the sort function and the Pivot Table. The
sort method is best used for relatively small collections, whereas the Pivot
Table is useful for examining more massive datasets and efficiently sorting
objects. Use the sort feature on the data set below, and it is possible to count
the number of people with allergies and decide how many of them are male
or female. The data are sorted first by diagnosis and then by gender.

Tips for Analyzing Data

Before using the sort feature or Pivot Tables, the data must be "cleaned." This
implies that the first step in the data analysis is to go through the data to
ensure that the data entry style is compatible with the columns. In this case, it
is necessary to make sure that only one word, phrase, or abbreviation is used
to identify each diagnosis. If several terms are used to explain the same thing
—for example, if "allergy" is written in the report as "allergy" —the research
would be more complicated, so it is best to use one term and use it



consistently. 

It may be appropriate to modify the terms used in the data set to be consistent
throughout; such adjustments should be made at this introductory level.
When multiple diagnoses occur for a single patient, it is necessary to list the
diagnoses separately. Columns labeled "Diagnosis 2" and "Diagnosis 3" will
need to be established, listing one diagnosis in each column. (If this is the
case, several Pivot Tables can be generated and results manually applied
together.) Using Microsoft Excel, first select the data ('Ctrl-A' selects all).

Choose the "Information" tab at the top of the Excel toolbar. Then press the
sort feature (circulated in blue below). In the window that shows up, select
"Sort by Sex." To sort by gender again, click the button in the upper left
corner of the window that says, "Add Category." Instead, press "Sex" and the
"OK" button. 

Sorting is a great tool for detecting patterns and analyzing small amounts of
data. In the example above, once the data is sorted by diagnosis and then by
gender, count the number of people for each examination and report the
gender breakdown, which could be done either manually or making use of the
Excel "COUNTIFS" formula. To enable the formula to count the number of
females diagnosed with an allergy, pick an empty
cell and type "= COUNTIFS," followed by the set and criteria. In this case,
the first range is D2: D23 and the first criterion is
"Allergy."

The second range is known as C2: C23 and the second range is "F." Press
"Enter" and the amount of individuals who have this allergy diagnosis and are
female is detected in the cell.

This calculation is an ideal way to count individual data if it's too time-
consuming to count manually. Modify the range and the
parameters in the formula to analyze the various subgroups.

For massive data sets, manually counting or using a counting algorithm can
be tedious and generate opportunities for error. Pivot Tables can
automatically sort data and list values to create valid and accurate
information. To generate a Pivot Table, select the data, click the "Insert"



button, and then select the "Pivot Table." (For Macs, click the "Numbers"
button, and then select the Pivot Table.) 

The "Pivot Table" will initiate a new Excel file sheet. The next step is the
incorporation of values. There is a box on the right that says, "Choose fields
to add to list." To the first sort by diagnosis, move the "Diagnosis" label (the
one with the checkbox next to it) to the "Line" box.

Next, to decide how many people have each diagnosis, drag "Diagnosis" (the
one with the checkbox next to it) to the "Values" box. To filter by gender,
drag "Sex" to the "Points" column, and Excel offers an automated overview
that can be used to measure percentages and to construct graphs.

Instead, to filter first by gender and then by diagnosis, alter the order of "Sex"
and "Diagnosis" in the "Rows" column.

Fields can be added or omitted as required. It can be useful to practice pulling
various fields into different categories to gain an understanding of how Pivot
Tables work.

When the data is processed, it is also helpful to construct a show so that
everyone can quickly and easily interpret the findings. One method to
achieve this is to develop an Excel-based map. First, build another table to
more conveniently display the breakdown of the number of males and
females with a diagnosis. Do this by moving the "Sex" field from the "Rows"
column to the "Columns" section. First, click "PivotChart" on the "Analyze"
tab, and choose the "Stacked Column" option. It shows the number of males
and females with each diagnosis stacked on top of each other.

After the chart has been developed, click the green plus sign in the upper
right-hand angle of the chart to combine the chart and axis names, add data
labels, format the color scheme, and cover the field settings.

Once the chart has been modified, it clearly shows essential trends in the
data. For example, one can easily see from this chart that no females have
been diagnosed with conjunctivitis or presbyopia.

When analyzing the data, it is essential to report all the results, even if they



seem insignificant. It is also important not to mix the study of data and make
generalizations. For example, research conducting a Visual Aid Effectiveness
Study to Improve Cataract Awareness offers a 10-question survey to patients
before and after visual aid has been given. The researcher finds that visual
assistance raises the total number of questions answered correctly. It's a
decent start, but it's not enough. The researcher must analyze the outcomes of
each particular query. Only understanding that intervention improves overall
awareness offers little detail about the benefits and limitations of the
response. Perhaps the intervention has led to a substantial rise in the number
of people who understand what a cataract is, but not in the number of people
who understand proper post-operative procedures. This is crucial to learn as
the intervention can then be changed to communicate better the information
required.



PRACTICAL APPLICATIONS

HOW TO CREATE AN INVOICE

The elements of the invoice can be regarded as the most significant
components of the transaction as proof. Most businesses, either small or large
corporations, would allow you to invoice them for their orders. Invoice is
essential to maintain a detailed record of business transactions in terms of
quality, quantity, and descriptions of goods or services. Typically, the invoice
can come with several copies, so you and your company will have one as
evidence to prevent unnecessary disputes in the future.

Microsoft Excel is typically a system designed to perform automated
calculations. This may perform mathematical calculations such as the
addition, multiplication, or subtraction of data by simply entering the coding
details called functions in the software.

As such, it is best to build invoices because the results would be generated
automatically as the data changes take place. There are mostly a few quick
steps you can take to make an invoice.

If you're going to need to make the headings, in the first row, enter the
headings for the invoice components. Commonly used headings should
include quantity, commodity, quality, date, subtotal commodity, and
discounts. Then you need to start organizing the cells. Any cells containing
messages, including those with currency or dates, should be formatted. To set
up a cell, you can click on the cell and then pick "Format Cells." Choose the
"Year" in the Category box for any year pieces. Then select the form you
like. There is a "Currency" choice in the currency cell category window.

First, the key to whatever data you need. Enter the details for each good or
service purchased.

If you do not have the details at your fingertips, you might want to empty a
few rows to see how the invoice may look. Include the formula or subtotal of
the commodity in Microsoft Excel as well. To determine the subtotal for each
element, select the subtotal, then type "=sum(" in the formula bar.



Then pick the cells that contribute to the subtotal, such as discounts, price and
quantity, and press "Enter" to close the formula. And continue to make the
complete cells. Choose all cells in the row that make up the subtotal cell.
Then click on it and select "Cell Format." Select the "Alignment" button, then
the "Merge Cells" button on the "Text Power" list.

Next, pick "Correct" from the "Horizontal Alignment" tab and insert
"Subtotal" in the window.

Following that, the secret to the invoice formulas. Choose the subtotal section
and type"= sum" (and choose the rows that contain the subtotal of the
product. Then press "File" to close the formula. Select the "Taxes" section
and the "=[invoice subtotal cell]*[tax percentage]" page.

First, select "Enter" to close the formula and start with the "Full" window.
Type "= sum" (and pick "Taxes" and "Subtotal" cells before clicking "Enter"
to close the formula.

How to Create an Invoice from an Excel Template (Windows)

Businesses that use customized Excel templates for invoicing their
customers. To build an invoice from an Excel template on a
Windows Desktop, follow the following steps: 

1. OPEN MICROSOFT EXCEL: You will first need to launch Microsoft
Excel on your Desktop to start making an invoice from an Excel
template.

2. SEARCH FOR INVOICE TEMPLATE: When Excel has been opened on
your screen, use the search bar at the head of the window and input
"invoice" to locate invoice templates. Make sure you're linked to the
internet to make a quest.
3. CHOOSE YOUR TEMPLATE: Browse through various invoice template
options to find one that works for your company. Excel provides a range of
invoice models, from sales invoices to operation invoices and delivery
invoices. Use a template that matches your needs and has a style that suits the
company's branding needs.

4. OPEN THE INVOICE TEMPLATE: When you have selected a template
that works for you, choose the template to preview it, and then select the



"Edit" button to open the Excel template in the new window.

5. CUSTOMIZE THE INVOICE: After you have opened a new spreadsheet
using your chosen template, you may need to change the invoice to represent
the specifics of your project. Make sure to include the following information: 
• Your logo, if you have one; 
•Your company contact information, including your name, address, phone
number, and email address; 
• Your customer contact details; 
• Invoice date;
• Specific invoice number; 
• Payment due date; 
• A numbered list of your services coupled with brief explanations, hours
worked or quantity and cost; 
• A subtotal for your service.

6. SAVE THE INVOICE: 
Once you have applied all the relevant details to your invoice, save the
completed file to your device. Save the file as a ".xlxs" format document so
that you can edit it later if needed. You may also save the file as a PDF file
and give it to your client so that it
can't be updated.

7. SEND THE INVOICE: 
Send a full invoice to your customer, either via email or by fax. Include a
brief cover notice that outlines important information, such as the due date of
the invoice and the total amount owing.

How to Create an Invoice from an Excel Template (Mac) 

To prepare an invoice using an Excel template on a Mac computer, follow the
following invoicing steps: 
1. Access MICROSOFT EXCEL:
Access Microsoft Excel first. Click the file in the menu bar, and then select
New in the template. The page will start with a set of available templates.

2. SEARCH FOR INVOICE TEMPLATE: To filter the results of the
template, click the scan bar in the upper right-hand edge of the current page,



type "invoice," and press enter to scan.

3. CHOOSE YOUR INVOICE TEMPLATE: There are several Excel invoice
templates to choose from, including business invoice templates and templates
that use formulas to measure taxes automatically. Choose one that offers all
the details you need and features a design that fits with the branding of your
company.
4. DOWNLOAD THE TEMPLATE:
Once you have found an Excel template to fit your business needs, click on
the template to open the preview tab. Then press the "Build" button to open a
new spreadsheet.

4. CUSTOMIZE YOUR INVOICE: Update the invoice template to provide
detailed descriptions of the project. Don't forget to give the subsequent
details:
• Your logo, if available;

•Your business contact particulars, including your name, address, telephone
number, and email address;
• Your customer contact information; 
• Specific invoice number; 
• Invoice date;
•An itemized list of the services you rendered to the customer, including the
quantities or hours worked and the rate of pay; 
• A subtotal for each of the services you provided to the customer. 

5.SAVE THE INVOICE
When you have finished all project details on your invoice, save the

spreadsheet to your machine in both xlxs and PDF formats. If
you send the invoice to your client, use the PDF version so that it can not be
changed after you submit it.

6. Give THE INVOICE: Send the invoice to your client via email or fax.
Include a short notice that includes vital information of the invoice, such as
the payment date and the total sum due.

How to Create an Invoice with Excel from Scratch

Learn how to build an invoice from scratch in Excel by following these



simple steps: 

1. OPEN A BLANK EXCEL WORKBOOK: To start making a new invoice
in Excel, open Microsoft Excel on your device and then press Open a Blank
Workbook. A new blank spreadsheet will be opened.
2. CREATE AND INVOICE HEADER: Apply a header to your invoice.
Include relevant payment data in the header, including 
• Your logo;
• Your company contact information; 
• Date of invoice; 
• Special invoice number. 

3. ADD THE CLIENT INFORMATION: Provide the contact information of
your client, including the name, address, email, and telephone number of the
contact person concerned.

4. Name THE PAYMENT DATE: Please display the payment due date on
your invoice. Write out the exact due date, i.e., "Payment due on 31
December 2018" instead of more ambiguous terms, such as "Payment due on
30 days," which can lead to misunderstanding and missed payments.

3. ADD AN ITEMIZED LIST OF SERVICES: Build an itemized list of the
services you have received. Create a column for a summary of each
operation, a column for the quantity of
time worked, and a column for your payment. Then provide a final column
with a subtotal for each of the services listed.

6. ADD THE TOTAL AMOUNT OWING: 
One advantage of making invoices in Excel is that the spreadsheet will do the
math for you. Use the Excel SUM feature to measure the total amount due
and add it to the bottom of the invoice. For example, if you need to add the
subtotals in Column C from cell 4 to 8 to determine the total sum due, enter
the following formula in cell C9: = SUM(C4: C8) 7. INCLUDES your
payment terms Apply your payment terms to the bottom of the invoice,
including the payment forms approved and specifics of your late payment
policy.



HOW TO CREATE A
BUDGET PLAN

Using spreadsheets to help you prepare your budget can be helpful as it can
help with complicated equations so you can see incomings and outgoings at a
glance. It also ensures that any changes to the data can be changed
automatically in the spreadsheet calculations so that it does all the hard work.

Having the budget in this manner can be used for several different items,
such as Christmas planning.
This guide teaches and informs you on how to develop a budget spreadsheet
for Microsoft Excel.

Machine with Excel Installed

Follow these step-by-step instructions to build a budget spreadsheet using
Excel.

Step 1: Open Excel so that you have a blank spreadsheet.
Step 2: You need information on the spreadsheet to determine the figures for
your budget. In a clear budget, we need to provide estimates in 'income' and
'expenditure' (expenditures). Excel is going to maximize revenue and cost for
you.
Step 3: Bring in the months you want the budget to run. Input each month in
an individual cell along one row of the spreadsheet. 
Step 4: Insert the heading for your income and then below it any sub-
headings for the type of income you earn, such as salary, pension, and
benefits.
Step 5: We need to include your expenditure now. In the same section where
you wrote your income forms, you need to add categories of spending, such
as rent or mortgage payments, electricity costs, shopping, recreation, TV
licenses, investments.
Step 6: As soon as you have these headings in your spreadsheet, you can start
making calculations so that when you enter figures
later Excel will automatically calculate any totals.
Step 7: Press the cell where you want the number to be.
Step 8: Then press Autosum in the ribbon menu.



Step 9: Select and drag the cells that you want to be included in this sum so
that the cells are illuminated. Click the Enter tab.
Step 10: Once you have obtained the formula in your first cell, you can now
copy that cell and paste it into all the other cells that need the same formula.
Step 11: Now, you need to do the complete production, repeat the steps above
under your 'Expenditure' portion.
Step 12: You might also want to know the difference between your income
and your production. Click on the cell where you want this number – surplus
– to be displayed to measure this amount. Then press Autosum and press on
the first number that you want to use in your estimate, in this case, Total
Income. Click the minus-) (key on your keyboard now. Now tap the Ctrl key
on the keyboard and, while keeping it down, pick the second number that you
want to use. In this case, the 'True' expenditure. To complete the estimate,
press In.
Step 13: Again, copy the entire row of this calculation.
Step 14: Now, you need to add your relevant revenue and expense estimates,
and Excel will calculate the totals. You may also want to use formatting
functions like bold or italic to make your budget spreadsheet simpler and
more appealing.



HOW TO CREATE A CREDIT

CALCULATING

Excel-is a flexible analytical and computational method mostly used by
lenders (banks, investors, etc.) and borrowers (businessmen, businesses,
private individuals, etc.).

Quickly navigate through complex formulas, measure interest, payouts,
overpayment to enable Microsoft Excel system functions.



HOW TO CALCULATE CREDIT PAYMENTS IN EXCEL 

The monthly payments are subject to the loan repayment scheme. Annuity
and separate payments are made:

1. The annuity assumes that the client makes the same amount each month.

2. When the separate debt servicing scheme before the interest of the
financial institution is paid to the balance of the value of the loan. Monthly
payments would also be every.

Increasingly used annuity: it is more efficient for the bank and more
convenient for the majority of customers.

Calculation of annuity payments for a loan in Excel The monthly annuity
payment is determined as follows: S = C * V where:
• S – number, is the amount of the loan payment;
• C – coefficient, is the rate of the annuity payment;

• V – is thе value оf the lоаn.

The аnnuіtу factor Formula: C = I * (1 + I ^ n)/((1 + I ^ n-1)
• whereas I – the exact interest rate for the month, the product of dividing the
annual rate by 12;
• n – the duration of the loan in months.

There is a special feature of Excel that says annuity payments. It is the
following: = PMT).

1. Fill in the input data for the measurement of monthly credit payments. This
is the sum of the loan, the interest, and the term.
2. To make the payment plan. It's empty till now.
3. In the first cell of the column "Income payments," the formula for the
calculation of loan annuity payments in Excel was introduced: =
PMT($B$3/12,$B$4,$B$2). The utter connections are used to connect the
cells. The formula can be applied directly to the numbers and not to the
reference cell details. Then the form will be as follows: = PMT(18
percent/12,36,100000).



The cells turned red, so we're going to send the money to the bank and lose
the money.
Computation of amounts in Excel for the differentiated payment system The
differentiated payment method means that:
• the principal sum is allocated in equivalent installments over the payment
period; 
• the interest accumulated on the balance of the loan.

The formula for calculating the differential payment: DP
= NEO/(PP + PS * NEO) where: 
• DP – is the monthly cost of the loan; 
• NEO – is the balance of the loan; 
• PP – the residual amount before the completion of the repayment period; 
• PS – is the interest rate each month (the average price divided by 12).
Create a timetable for the repayment of the previous loan under the
differentiated system.

Input dates are the same: loan sum of credit $100 000 Interest rate 18 percent
Period of months 36 To make the payment schedule of
the loan: the number of months Balance receivable on the 'loan Payment' of
interest Payment of Final principal payment one month Balance receivable on
loan In the following and subsequent-calculated formula: = IF(D10>$B$4,0,
E8-G9).
• D10 – the amount of the current contract; 

• B$4 – the duration of the loan; 
• E8 – the balance of the loan in the previous era; 
• G9 – the principal debt during the last period.

Interest payment: balance of the loan in the current period multiplied by the
average interest rate of 12 months: = E9*($B$3/12).
Payment of principal: the total amount of the loan divided by the duration: =
IF(D9<=$B$4,$B$2/$B$4,0).
Final payment: the amount of 'interest' and 'primary debt' in the current
period: =F8+G8.
We substitute for the formulas in the corresponding columns. Copy it to the
entire table.

In comparing the overpayment on the annuity and the differentiated payment



scheme on loan: the red figure – the annuity (100 000 rubles were taken), the
black one – is the differentiated method.



INTEREST CALCULATION FORMULA FOR LOANS IN
EXCEL

Calculation of loan interest in Excel and calculation of the effective interest
rate, with the following information on the bank offer
credit:
Fill in table type: The fee is taken from the total sum monthly. The full cost
of the loan-this is an annuity cost plus a price. The amount of the principal
debt and the amount of the interest – there are elements to the payment of the
annuity.

The principal sum = payment of the annuity – interest.

The amount of interest = the outstanding debt * the monthly interest rate.

The balance of principal = the remainder of the previous period – the amount
of the principal debt of the last period.

Based on the monthly payment table, measure the effective interest rate: 
• Take the credit of 500 000 rubles; 
• Return to the bank-684 881 rubles. 67 rubles (the amount of all payments on
the loan); 
• An overpayment of 184 881 rubles. 
• Interest rate-184 881 67/500 000 * 100, or 37 per cent.
• The harmless fee of 1% was too costly for the borrower.

The effective interest rate of the loan would be 13 percent without a fee.
Counting is performed in the same way.



THE CALCULATION OF THE EFFECTIVE INTEREST
RATE IN EXCEL

The current formula is now applied in compliance with the Consumer Credit
Act for the calculation of the effective interest
rate. EIR (Effective Interest Rate) is defined as a percentage of up to the third
decimal place according to the following formula: 
• EIR = I * CHBP * 100; 
• Where I interest rate of the base period; 
• NBP- the number of base periods in the calendar year.

Take, for example, the following dates for the loan: a payment schedule is
essential for the calculation of the effective interest rate.
The base period (BP) must be calculated. The law notes that this is the
average time interval used in much of the repayment plan.
Example BP = 28 days in duration.

Then we will find NBP: 365/28 = 13.

Now one can find the interest rate of the base period: we have all the required
dates-substitute them in the EIR formula: = B9*B8 To obtain the percentages
in Excel, you do not need to subtract by 100. It's enough to set the result to
the percentage format for the cell.

The EIR for the new calculation coincides with the average interest rate on
loan.

Download the credit calculator in Excel
The most basic PLT feature is used to measure the annuity payments on the
loan. As you can see, the specific way to repay is a little more complicated.



CONCLUSION

GLOSSARY

Workbook — the workbook refers to the Excel spreadsheet file. The
workbook includes all the data you entered and helps you to arrange or
measure the results. A workbook that is available for reading and editing
several users on a network is known as the Shared Workbook.

Worksheet — there is a workbook where you can find papers called
worksheets. Often known as spreadsheets, you can have several worksheets
nestled in your workbook. The tabs below the screen will show which of your
worksheets you are working on. This is also known as an active working
surface or a vibrant board.

Cell — a cell is a rectangular or a cube contained in a worksheet. Any data
that you want to enter in your worksheet must be stored in a container. Cells
can be color-coded, text displayed, numbers, and measurement results
depending on what you want to do. The Active Cell is one that is currently
being opened for editing.

Columns and Rows — refer to the orientation of the cells. Columns are
vertically oriented, while rows are horizontally aligned.

Column and Row Headings — headings are usually lettered and numbered
gray areas located just outside the columns and rows. The entire row or
column will be picked by clicking on the heading. You may also adjust the
height of the row or the width of the column using the headings.

Workspace — like worksheets in a workbook, a workspace helps you to
access several files simultaneously.

Ribbon — above the workbook, there's a segment called the Ribbon
command tabs. A multitude of options is contained behind each tab of the
ribbon cell reference where a cell reference can be said to be a set of
coordinates that defines a particular cell. This is a mix of letters and numbers.
A5, for example, will point to the cell where column A and row 5 intersect.

Cell Range — the Cell Range is a range of cells that have been classified as a



category based on a number of criteria. Using a colon (:) between cell
references, Excel will evaluate the set, often known as an array. 
A range in a row, for example, would look like A1: C1, making the formula
to look at cells in a row between A1 and C1, while B4: D9 will inform the
formula to view all cells in a box bounded by columns B and D and rows 4
and 9. The 3-D comparison refers to a range that involves more than one
worksheet in the same workbook.

Fused Cell — When two or more cells are joined, it becomes what is known
as a merged cell.
Prototype — the prototype is a formatted workbook or workbook designed to
help users meet the basic needs of Excel. Examples of this include inventory
analysis, process diagram, and calendar.

Operator — the operator is a symbol or a sign that shows which calculation
must be made in an expression. Operators do not generally refer to specific
mathematical types; there are also similarities, text concatenations, or
reference operators.

Formula — a series within a cell that is used to produce value; It must start
with an equal (=) symbol. 
This may be a mathematical equation, a cell relation, a function, or an
operator. A formula is often referred to as an expression.

Formula Bar — contained between the ribbon and the workbook, the
Formula Bar shows the contents of the active cell. In the case of formulas, the
bar of the formula will represent all the components of the formula.
Function — The functions are formulas that are pre-built in Excel. They are
structured to help simplify potentially complicated formulas in the workbook.

Error Code — Error Codes will appear if Excel finds an issue with the
formula given.
Cell Formatting — This can be defined as the act of modifying the way the
cell data is represented in the spreadsheet. Once you format cells, only the
external appearance of the cells is changed; the meaning inside the cells
remains unchanged.

Conditional Formatting — Formatting is implemented only if the cell meets



specified requirements such as duplicate values or values above or below the
threshold.

Filter — Filters are the rules that you can use to determine which rows to
show in the worksheet. Such filters can use data such as conditions or values.

Freeze Panes — Frozen Panes allows you to pick different columns and rows
to stay apparent on the worksheet, even as you are scrolling, such as the
header cells that mark a column.

AutoFill — this helps you to copy data to more than one cell quickly.

AutoSum — this function removes the numbers you entered in your sheet
and shows the total in the cell of your choice.

AutoFormat — this is an automatic cell format program that meets pre-
defined criteria. It may be as easy as aligning fonts and sizes.

Data Validation — this feature helps prevent inaccurate data from accessing
your worksheet. It is most widely used to build drop-down lists for specific
words. The authentication of data ensures the continuity and precision of the
data to be entered.

Pivot Table — this is the most widely used data review method to sort,
average, and automatically summarizes results. The knowledge is taken from
one table while the figures are shown in another. Pivot Tables makes it easy
to access precise information from a significant data source.

Pivot Chart — this type of chart offers visual support for pivot tables. By
offering graphical representations of pivot table data, the user may have a
degree of data interaction.

Pivot Area — the pivot area is a point on the worksheet where you can drag
the Pivot Table region to re-order how the report is presented.

Source Data — this is the information you use to build your pivot table. It
can either exist in the worksheet or an external database.
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